Chromebooks and SQA Assessment Arrangements

Citation for published version:

Link:
Link to publication record in Edinburgh Research Explorer

Document Version:
Publisher's PDF, also known as Version of record

General rights
Copyright for the publications made accessible via the Edinburgh Research Explorer is retained by the author(s) and / or other copyright owners and it is a condition of accessing these publications that users recognise and abide by the legal requirements associated with these rights.

Take down policy
The University of Edinburgh has made every reasonable effort to ensure that Edinburgh Research Explorer content complies with UK legislation. If you believe that the public display of this file breaches copyright please contact openaccess@ed.ac.uk providing details, and we will remove access to the work immediately and investigate your claim.
The use of Chromebooks by candidates who require Assessment Arrangements in Scottish Qualification Authority external examinations.

Paul Nisbet, with Shirley Lawson, Craig Mill, Robert Stewart

August 2019
Contents

Summary and conclusions ............................................................................................................. 6
Use of ICT to write answers (no DQP) ....................................................................................... 7
   No Spellcheck ............................................................................................................................ 7
   Permission to use Spellcheck ................................................................................................... 8
Use of ICT plus ‘Question Only’ Digital Question Papers .......................................................... 8
Use of ICT plus ‘Question and Answer’ Digital Question Papers ................................................ 9
Chromebook Accessibility options ............................................................................................. 9
Conclusions .................................................................................................................................. 10
Areas for development .............................................................................................................. 10
Research Questions .................................................................................................................... 11
Methods ...................................................................................................................................... 12
Technology as an Assessment Arrangement .............................................................................. 13
Security requirements ................................................................................................................ 14
   Spellcheck and literacy support tools ....................................................................................... 14
Technology management in SQA Examinations ....................................................................... 15
Exam profiles and accounts ....................................................................................................... 15
Scenarios for use of technology as Assessment Arrangements ............................................... 16
   Use of ICT to write answers (no DQP) .................................................................................... 16
   Use of ICT with Question-Only Digital Question Paper ....................................................... 16
   Use of ICT with Question-and-Answer Digital Question Paper ............................................ 16
Chromebooks ............................................................................................................................ 17
Use of ICT to write answers (no DQP) ..................................................................................... 20
Digital Answer Booklets (DABs) .............................................................................................. 20
SQA DABs in doc format ........................................................................................................... 20
SQA DABs in PDF ....................................................................................................................... 22
   Chrome PDF Viewer ................................................................................................................ 22
   DocsPlus ................................................................................................................................. 22
   Kami ..................................................................................................................................... 23
   Texthelp PDF Reader ............................................................................................................. 23
   Xodo ...................................................................................................................................... 23
Spellcheck in PDF DABs ............................................................................................................. 24
Summary ..................................................................................................................................... 24
Digital Answer Booklets for Chromebooks ............................................................................... 25
Accessing DQPs and PDF DABs with Chromebooks

Chromebook word processors and text editors ................................................................. 26
Google Docs ...................................................................................................................... 27
Microsoft Word app ........................................................................................................... 31
Microsoft Word Online ..................................................................................................... 31
Google Office File Editor ................................................................................................. 32
Google Forms .................................................................................................................... 32
DocsPlus ............................................................................................................................ 32
Disabling Chrome Spellcheck and writing supports ......................................................... 33
Commercial assessment platforms .................................................................................... 33
Summary of Chromebook tools for use of ICT to write answers ...................................... 34
Candidates who do not have permission to use Spellcheck.............................................. 35
Candidates who do have permission to use Spellcheck ..................................................... 35
Digital Question Papers .................................................................................................... 36
Background ........................................................................................................................ 36
Accessibility features of SQA Digital question papers on Windows OS .......................... 38
Opening and saving DQPs and DABs ................................................................................ 38
Zoom / magnify .................................................................................................................. 38
Colours ............................................................................................................................... 38
Text Readers ...................................................................................................................... 38
Screen Readers .................................................................................................................. 39
Navigation .......................................................................................................................... 39
Answer boxes and interaction ............................................................................................ 39
Physical support needs ...................................................................................................... 40
Spellcheckers and literacy support tools ........................................................................... 41
Mathematics and science ................................................................................................. 41
Accessing DQPs and PDF DABs with Chromebooks ........................................................ 43
Question Only Digital Question Papers ............................................................................ 44
Tools for accessing Question Only DQPs ........................................................................ 44
Viewing DQP and answers side by side .......................................................................... 45
Question and Answer Digital Question Papers ................................................................. 46
Tools for accessing Question and Answer DQPs ................................................................ 46
Chrome PDF Viewer ........................................................................................................... 48
Summary ............................................................................................................................... 48
Pricing ................................................................................................................................. 48
<table>
<thead>
<tr>
<th>Product</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>DocsPlus</td>
<td>Summary</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Pricing</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Question Only Digital Question Papers</td>
<td>50</td>
</tr>
<tr>
<td></td>
<td>Question and Answer Digital Question Papers</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td>Examination arrangements</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td>More Information</td>
<td>51</td>
</tr>
<tr>
<td>Kami for Schools</td>
<td>Summary</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>Pricing</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>Question Only Digital Question Papers</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>Question and Answer Digital Question Papers</td>
<td>52</td>
</tr>
<tr>
<td></td>
<td>Examination arrangements</td>
<td>53</td>
</tr>
<tr>
<td></td>
<td>More Information</td>
<td>53</td>
</tr>
<tr>
<td>Snap&amp;Read</td>
<td>Summary</td>
<td>54</td>
</tr>
<tr>
<td></td>
<td>Pricing</td>
<td>54</td>
</tr>
<tr>
<td></td>
<td>Question Only Digital Question Papers</td>
<td>54</td>
</tr>
<tr>
<td></td>
<td>Question and Answer Digital Question Papers</td>
<td>54</td>
</tr>
<tr>
<td></td>
<td>Examination arrangements</td>
<td>54</td>
</tr>
<tr>
<td></td>
<td>More Information</td>
<td>54</td>
</tr>
<tr>
<td>Texthelp PDF Reader</td>
<td>Summary</td>
<td>55</td>
</tr>
<tr>
<td></td>
<td>Pricing</td>
<td>55</td>
</tr>
<tr>
<td></td>
<td>Question Only Digital Question Papers</td>
<td>55</td>
</tr>
<tr>
<td></td>
<td>Question and Answer Digital Question Papers</td>
<td>55</td>
</tr>
<tr>
<td></td>
<td>Examination arrangements</td>
<td>56</td>
</tr>
<tr>
<td></td>
<td>More Information</td>
<td>56</td>
</tr>
<tr>
<td>XODO PDF Viewer and Editor</td>
<td>Summary</td>
<td>57</td>
</tr>
<tr>
<td></td>
<td>Pricing</td>
<td>57</td>
</tr>
</tbody>
</table>

Chromebooks for SQA Assessment Arrangements Revised 7/1/20
Appendix 1: Setting up Chromebook accounts for SQA Examinations

References

Comparison of apps/extensions for accessing Digital Question Papers on Chromebooks

Technical Administration of Chromebooks in SQA examinations

Step 1. Set up Chromebooks for use in examinations

1. Setup a domain name for your school

2. Sign up to Google’s G Suite for Education Programme

3. Purchase a Chrome Education licence for each device

4. Set up Google Accounts for each Chromebook

5. Use the Google Admin Console to setup the Chromebooks

5.1 Enrol Chromebooks

5.2 Add users
5.3 Restrict access to the internet ................................................................. 73
5.4 Install apps and extensions .................................................................. 74
5.5 Configure ‘pinned’ apps ....................................................................... 75
5.6 Set up printing ...................................................................................... 77

Step 2. Making Digital Question Papers available to the Chromebook .......... 78
Step 3. How to access the digital paper on the Chromebook ....................... 79

What the candidate does during the exam .................................................. 80
What to do when the exam is complete ...................................................... 80

Appendix 2: Chrome PDF Viewers ............................................................. 81
Appendix 3: DocsPlus .................................................................................. 85
Appendix 4: Kami ...................................................................................... 91
Appendix 5: Snap&Read PDF Reader ......................................................... 94
Appendix 6: Texthelp PDF Reader .............................................................. 97
    Screenshot reader .................................................................................. 98
Appendix 7: Xodo .....................................................................................101
Summary and conclusions

Technology in the form of a computer or word processor has been used by candidates with Additional Support Needs or disabilities as an Assessment Arrangement in SQA exams for many years, and Digital Question Papers\(^1\) (DQPs) have been available from SQA since 2008.

The majority of candidates currently use Windows laptops or computers, and the technology has proved reliable and practical for centres and candidates. In 2018, 59% of Scottish state schools requested DQPs (source: data from SQA).

Chromebooks have been and are being purchased by some local authorities and schools in Scotland and consequently SQA commissioned CALL to research the implications of using Chromebooks for Assessment Arrangements in SQA examinations.

CALL has carried out research and testing and liaised with colleagues in Google, schools and local authorities and software developers, and this report summarises the status at this point in time.

The focus of this report is on candidates who require Assessment Arrangements, although the discussion is also relevant for candidates who do not require Assessment Arrangements and who wish to use a Chromebook to type their answers in examinations.

Technology used in examinations must meet SQA requirements in terms of security; centres’ requirements in terms of accessing DQPs and typing up or otherwise producing answers; and candidates’ requirements in terms of accessibility and usability. Regarding security, candidates must not be able to access information on the internet or other digital storage, and support tools such as Spellcheck cannot be used unless the candidate has permission to use them.

Centres and candidates may use DQPs and/or technology in examinations to meet a range of different needs, and here we summarise our findings with respect to Chromebooks across three different Assessment Arrangement scenarios:

- **Use of ICT to write answers (no DQP);**
- **Use of ICT with a ‘Question-Only’ DQP;**
- **Use of ICT with a ‘Question and Answer’ DQP.**

Technology is changing rapidly – over the course of this research there have been developments both in terms of the accessibility tools built into the Chrome OS and with apps and extensions available from third-party providers. This continually changing technological context has delayed the publication of this document and does in our view contribute to uncertainty for staff and candidates regarding the use of Chromebooks in examinations because the devices and how they function appear to change, sometimes without warning. This situation is of course not confined to Chromebooks – it also applies to software and devices based on Windows and iOS.

Consequently the tools and systems described in this report will change. We hope that this report provides a summary of the current status for SQA, schools and teachers, local authorities, and software providers, and help to inform development of both technology and pedagogical practice.

\(^1\) Digital Question Papers, [https://www.sqa.org.uk/sqa/30030.html](https://www.sqa.org.uk/sqa/30030.html)
Use of ICT to write answers (no DQP)
In this scenario the candidate reads or accesses the conventional printed question paper and uses technology to type, dictate or otherwise record a response.

SQA provide Digital Answer Booklets (DABs) in PDF and .doc format for candidates when using ICT to write answers.

We tested a range of PDF readers and editors with the SQA Digital Answer Booklets in PDF and found that none of them offered a satisfactory solution for use in examinations. Details are in the later section on SQA DABs in PDF.

We tested a range of word processors and other writing tools commonly available on Chromebooks in schools, including Google Docs, Google Office File Editor, Google Forms and Microsoft Word (app and Online). We also reviewed paid-for software such as DocsPlus and DigiExam. The results are given in the section on Use of ICT to write answers (no DQP).

We found that the SQA Digital Answer Booklets (DABs) in .doc format do not function correctly in any of the word processors tested apart from the Microsoft Word app.

A key requirement for centres is to be able to restrict access to Spellcheck or other literacy tools where candidates do not have permission to use them. Some supports such as dictionary or definition tools are not allowed regardless of whether the candidate has permission to use Spellcheck (apart from in specific subjects or by candidates with English as an Additional Language (SQA, 2019a, 2019b) and so centres must be able to disable such features on Chromebooks.

No Spellcheck
We found that Google Docs may provide a solution for candidates who are not permitted to use Spellcheck or other literacy supports. When the device is disconnected from the internet, the support tools do not function. It may also be possible to configure the online Google Docs using the Google Admin Console such that the support tools are unavailable for use.

With Google Office File Editor and Google Forms we did not find a mechanism to securely disable the Spellcheck: while it can be turned off in Settings on the Chromebook, the candidate could turn it back on.

DocsPlus and DigiExam, which are paid-for products, have facility to disable Spellcheck and so may offer the required functionality for centres.

In conclusion, for candidates that do not have permission to use Spellcheck, centres might consider:

- Google Docs used offline or with restricted access to the Google Docs server;
- DocsPlus;
- DigiExam.

---

2 Google Docs https://www.google.com/docs/about/
3 Google Office File Editor, https://support.google.com/chromebook/answer/2481498?hl=en-GB
4 Google Forms https://www.google.co.uk/forms/about/
5 DocsPlus for Chromebook https://www.cricksoft.com/uk/docsplus/chromebook
6 DigiExam https://www.digiexam.com/
Permission to use Spellcheck

Where candidates do have permission to use Spellcheck, Voice Typing (Computer Dictation) or other accessibility tools (which is likely for candidates who require Assessment Arrangements), we found that with Google Docs it was not possible to enable Spellcheck while also disabling the Define and Explore functions that are not permitted. Unless this can be done, Docs is not suitable for use in examinations.

Candidates who have permission to use Spellcheck could use Google Forms and Google Office File Editor with the built-in Chromebook Spellcheck.

DocsPlus provides accessibility and literacy support tools that can be controlled using Exam Mode, so it may meet the needs of centres, while DigiExam also provides security and an optional text reader and Spellcheck.

For candidates that do have permission to use Spellcheck, consider:

- Google Forms;
- Google Office File Editor;
- DocsPlus;
- DigiExam.

Use of ICT plus ‘Question Only’ Digital Question Papers

In this scenario candidates read from a Question-Only Digital Question Paper, perhaps with support from accessibility tools such as a text reader, and answer using a word processor or text editor as discussed in the previous section.

We tested DQPs with several Chromebook PDF Viewers including: Chrome Browser; Chrome PDF Viewer; DocsPlus; Kami; Texthelp PDF Reader; Snap&Read and Xodo.

Out of these, centres might consider:

- Chrome PDF Viewer;
- Kami for Schools (Premium subscription version)\(^8\);
- Texthelp PDF Reader\(^9\).

for accessing Question-Only DQPs in conjunction with typing or producing answers in a word processor.

The other readers all have limitations that in our view make them currently unsuitable for use in examinations.

With the suggested tools, candidates with, for example, visual impairment can use zoom, magnification and high contrast adjustments to read the paper; candidates with reading difficulty can use text-to-speech to read the questions; candidates with physical disabilities can use a keyboard or mouse to navigate the paper.

---

\(^8\) Kami [https://www.kamiapp.com/](https://www.kamiapp.com/)

(A limitation with all the PDF readers is that the CereProc Scottish Computer Voices\textsuperscript{10} (Stuart, Heather and Ceitidh, the Gaelic voice and the new Andrew and Mairi child voices) are not currently available for Chromebooks. The Rhona Scottish voice from Acapela can however be purchased at a cost of around £6 per user\textsuperscript{11}.)

**Use of ICT plus ‘Question and Answer’ Digital Question Papers**

In this scenario candidates read the Digital Question Paper and type or dictate into on-screen answer boxes within the paper itself.

Of the PDF readers tested, only DocsPlus and Kami provide an AutoSave function, which we regard as essential for examinations.

However both DocsPlus and Kami have drawbacks: DocsPlus seems to limit the amount of text that can be typed into an answer box, while Kami uses the Chromebook Spellcheck for which we have not found a secure mechanism of disabling, so it is not suitable for candidates who do not have permission to use Spellcheck.

We therefore do not recommend Chromebooks for use with SQA Question and Answer papers at this time.

None of the six Chromebook PDF readers offer the same range of features and facilities that are available on Adobe Reader on Windows.

**Chromebook Accessibility options**

Chromebooks have a number of built in accessibility options\textsuperscript{12}, including:

- zoom and magnify;
- high-contrast mode;
- large mouse pointer;
- Select and Speak (text reader);
- ChromeVox, a screen reader;
- on-screen keyboard;
- voice typing (computer dictation);
- AutoCorrect,
- word prediction
- Spellcheck.

Other accessibility features such as screen tinting or text readers can be added with extensions; some free, some at a cost. Some accessibility tools such as eye-gaze and switch access are not available on Chromebooks.

\textsuperscript{10} Scottish Computer Voices, \url{http://www.thescottishvoice.org.uk/home/}
\textsuperscript{11} Acapela voices for Chromebooks \url{https://www.acapela-group.com/solutions/acapela-voices-for-chromebooks/}
\textsuperscript{12} Turn on Chromebook accessibility features \url{https://support.google.com/chromebook/answer/177893?hl=en-GB}
Conclusions
Chromebooks may be suitable devices for use by candidates who wish to use a word processor in an examination. To meet security requirements regarding Spellcheck and literacy supports, centres must use a word processor or text editor without Spellcheck or purchase commercial assessment/examination software. It may be possible to develop technical solutions to selectively enable and disable literacy support tools.

Chromebooks may be suitable also for candidates who need to view and read Question Only Digital Question Papers (subject to addressing the security considerations above).

For candidates who need to access Question and Answer Digital Question Papers, current tools available on Chromebooks are in our view not yet suitable.

In all scenarios, centres will have to configure the Chromebooks to prevent candidates from accessing information from the internet or on other digital sources.

Areas for development
Development work that could be considered by stakeholders to improve the current situation regarding use of Chromebooks by candidates who require Assessment Arrangements are:

- Development of software tools to disable Spellcheck, AutoCorrect, definitions, word prediction and other literacy supports to enable centres to meet SQA security requirements.
- Development of PDF reader and access tools to improve the user experience and accessibility options.
- Publishers of text reader extensions (including Google) might consider licencing and integrating computer voices with Scottish accents and a Scottish Gaelic voice.
- Development of digital answer booklet templates for use in Google Docs.
- Action research and collaboration with centres regarding the practical application of Chromebooks for candidates who use Assessment Arrangements.
- Development and publication of guidance on administration of Chromebooks in examinations to meet security and accessibility requirements.
Research Questions

The purpose of this investigation is to explore the use of Chromebooks for candidates who use Assessment Arrangements in SQA National 5, Higher and Advanced Higher examinations. More specifically, we wished to find out:

- How can Chromebooks be configured to meet administration and security requirements, in terms of restricting access to information sources and support tools such as spellcheckers that may not be permitted in the examination.
- How can Chromebooks be used to open and access Digital Question Papers in PDF.
- How candidates can type or record their answers using SQA Digital Answer Booklets, or a word processor or text editor.
- What accessibility options are available for candidates who require, for example, text-to-speech to read questions, or literacy support tools to record answers.
Methods

The CALL team used several methods throughout the research:

- A set of Chromebooks were kindly provided to CALL by Stephanie Shipley of Prowise, in conjunction with Google, to research and test options for configuring Chromebooks.
- Leigh Craig and Louise Jones, formerly of Google, provided Chrome OS Management Licenses for the devices and arranged access to Google Classroom and G Suite.
- Discussions and meetings took place with representatives of Google and some of the developers of the technologies discussed in this report.
- CALL staff joined and participated in the Google Education Group (GEG) Scotland\(^\text{13}\).
- Desk and internet-based research.
- Testing of apps and extensions for accessing Digital Question Papers, Digital Answer Booklets, and options for typing answers.
- Testing of accessibility apps and extensions.

\(^{13}\) Google Education Group (GEG) Scotland. [https://drive.google.com/file/d/11P7Yu--H6ZAY5tlueuV5IDfV1NMfv15z/view](https://drive.google.com/file/d/11P7Yu--H6ZAY5tlueuV5IDfV1NMfv15z/view)
Technology as an Assessment Arrangement

The purpose of Assessment Arrangements is to “provide candidates with an equal opportunity to demonstrate their attainment without compromising the integrity of the assessment” (Scottish Qualifications Authority, 2017a).

Assessment Arrangements can be used by candidates who are disabled or who have been identified as having particular difficulties with accessing the assessment using the standard arrangements (Scottish Qualifications Authority, 2017a).

Assessment Arrangements are requested to reflect the needs of the candidate and the specific assessment. A candidate may use different types of Assessment Arrangement in different examinations.

For example:

- A candidate with dyslexia might use a coloured overlay to help read the question paper, and extra time to write up answers.
- A candidate with a visual impairment might request a question paper in Large Print or Braille.
- A candidate with a hearing impairment may use sign language to access an assessment task.
- A candidate with a physical disability or handwriting difficulties might use technology or a scribe to record their answers.

The use of ICT and technology is a type of Assessment Arrangement. For example:

- A candidate with dyslexia might use a Digital Question Paper and change the screen colours or use a computer text reader to read the questions.
- A candidate with a visual impairment might access a Digital Question Paper on a computer or tablet and zoom in to magnify the questions.
- A candidate with a physical impairment who cannot handwrite or physically manipulate the question paper might use technology to access the question paper and write their answers.
- A candidate with a significant spelling difficulty might use speech recognition to record their answers.

One of the principles governing the use of Assessment Arrangements is that the integrity of the qualification must be maintained. With respect to technology, the centre must ensure that candidates cannot access any software tools or facilities that might give an unfair advantage over other candidates. For example, candidates should not be able to access the internet to research or use literacy support tools such as spellcheckers or speech recognition unless these have been requested as an Assessment Arrangement (Scottish Qualifications Authority, 2017b).
Security requirements

SQA policy on use of technology in examinations (Scottish Qualifications Authority, 2017c) requires devices to be made secure so that candidates cannot access information or supports inappropriately. Software tools and facilities that could give the candidate access to information that could confer an unfair advantage should not be available to the candidate.

In practice this involves:

- preventing access to the internet or only allowing access to specific services required for the examination;
- preventing access to network folders, USB sticks, Bluetooth, AirDrop or any other storage or communication facility;
- preventing access to tools that could give the candidate an unfair advantage such as Spellcheck, dictionary, definitions, thesaurus, AutoCorrect or voice typing.

Spellcheck and literacy support tools

SQA policy in examinations is that Spellcheck, Voice Typing or other facilities that support spelling and grammar can only be used where the centre has requested and received permission for the candidate and the examination. Otherwise, Spellcheck and literacy support tools must be disabled.

To help centres manage the use of spellcheckers, SQA produce ‘spellcheck enabled’ and ‘spellcheck disabled’ Digital Question Papers and Answer Booklets in PDF. When opened with Adobe Reader on PC, the spellcheck on the ‘spellcheck disabled’ files does not function. However, with Chromebooks (and iPads), spellcheck still operates on ‘spellcheck off’ digital papers and so other techniques are required to restrict access to the spellcheck.

With Digital Answer Booklets in .doc format, or use of word processor to type answers, school technicians and analysts use group profiles to disable spellchecking or remove the spellchecker dictionaries from Word so that the spellchecker does not function. This requires technical and network expertise and so is not a measure that can usually be undertaken by teaching staff or invigilators.

To use Chromebooks in examinations, centres must be able to restrict access to the following facilities that are provided as standard on the devices:

- Spellcheck;
- AutoCorrect;
- Predictive text;
- Dictation / voice typing;
- ‘Explore’ and ‘Define’ tools.
Technology management in SQA Examinations

Organising computers or devices for use as Assessment Arrangements in SQA examinations involves:

- physically locating devices in quiet locations where candidates will not be distracted, or distract other candidates;
- ensuring that security requirements are met (see below);
- arranging procedures for distributing Digital Question papers, if these are going to be used;
- arranging printers and procedures for printing;
- installing or giving access to the necessary software, apps and extensions for reading papers and for generating responses;
- installing or making available the necessary accessibility software, apps and extensions for reading papers and for generating responses.

Exam profiles and accounts

The most efficient approach to security in examinations for centres that use Windows machines is to create ‘Exam Profiles’ with group policies where the device is configured to only allow the software required for the examination and access to the network folder containing the DQP or DAB. The Exam Profile prevents access to the internet or to other file storage sources. It can also be used to disable the spellchecker and other literacy support tools built into Microsoft Word, that are not permitted in the examination.

In the case of Chromebooks, there are several techniques that may offer equivalent functionality and these are discussed in the section on Technical Administration of Chromebooks in SQA examinations.
Scenarios for use of technology as Assessment Arrangements

There are three main scenarios where Chromebooks might be used as part of an Assessment Arrangement.

Use of ICT to write answers (no DQP)
In this scenario, the candidate reads the questions from the hard copy question paper and writes or dictates answers using a word processor or text editor on the Chromebook.

Some candidates have permission to use Spellcheck and some candidates will not; for the latter, the centre must restrict access to Spellcheck or other tools such as Voice Typing (computer dictation), thesaurus or dictionary that could give an unfair advantage. Candidates with additional support needs may require specific support tools such as computer dictation or word prediction. Permission to use these in the examination must be requested with the SQA AAR system.

Use of ICT with Question-Only Digital Question Paper
In this scenario, the candidate reads the questions from a Digital Question Paper in PDF and writes answers using a word processor or text editor on the Chromebook. Candidates may use accessibility tools and options, such as zoom, a text reader, or coloured screen overlay to read the DQP.

Candidates will normally use a word processor or SQA Digital Answer Booklet (DAB) to type answers. Again, some candidates may require access to a spellchecker or other writing supports, while others should not have access. The use of writing supports such as computer dictation or word prediction may be requested from SQA.

Use of ICT with Question-and-Answer Digital Question Paper
In this scenario, the candidate reads the questions and inserts answers directly into ‘answer boxes’ in the Digital Question Paper PDF.

The candidate may use accessibility tools and options, such as zoom, a text reader, or coloured screen overlay to read the DQP, and writing supports such as spellchecker, word prediction or speech recognition (where permission has been sought and granted) to insert answers.
Chromebooks

Chromebooks are laptop or laptop/tablet computers that run the Google Chrome browser. They are relatively inexpensive, are light and have good battery life, and for large scale deployment, they are claimed to require fewer technical staff to maintain and update (O’Donnell and Perry, 2012; Google, 2018a) and are therefore attractive for schools and local authorities wishing to provide learners and staff with large numbers of personal devices (Molnar, 2014; Ahlfeld, 2017). Chromebooks are available from most of the major technology manufacturers including for example HP, Samsung, Asus and Toshiba.

Figure 4: Chromebook in laptop, tablet and ‘tent’ mode

Chromebooks are now being purchased by some schools and local authorities in Scotland in significant numbers: Highland, Aberdeen, Stirling and West Dunbartonshire have all invested in the devices (Highland Council, 2015; West Dunbartonshire Council, 2016; Stirling Council, 2018).

The picture across Scotland remains mixed with most local authorities maintaining Windows OS as the default system, while Glasgow and Scottish Borders have both begun programmes to provide iPads to every learner in P6 and above (Glasgow City Council, 2018; Scottish Borders Council, 2019).

A number of centres contacted CALL Scotland for advice regarding the use of Chromebooks as an Assessment Arrangement in SQA examinations, and so as part of the partnership programme with SQA, CALL has undertaken this research into use of Chromebooks for accessing Digital Question Papers and Answer Booklets.

14 https://www.google.com/chromebook/
Chromebook Accessibility Features

Chromebooks, like Windows and iOS devices, have built-in accessibility tools that may be helpful for candidates who require Assessment Arrangements in examinations. These include:

- zoom in/out;
- screen magnifier;
- high contrast mode where the screen colours are inverted;
- Select and Speak, a computer text reader;
- ChromeVox, a screen reader for users with significant visual impairment;
- reading the screen using a Braille display;
- Sticky Keys, for typing key combinations with a single finger;
- Voice Typing (computer dictation or speech recognition) for people who cannot use the physical keyboard;
- an on-screen keyboard.

Craig Mill at CALL Scotland has created a poster that summarises the main accessibility options.

Other built-in Chromebook features that can be helpful for candidates in an examination include:

- spellchecker;
- Automatic Substitution (AutoCorrect);
- Auto-capitalisation;
- Word prediction.

---

15 Chromebook Accessibility. [https://support.google.com/chromebook/topic/6323347?hl=en&ref_topic=3399710](https://support.google.com/chromebook/topic/6323347?hl=en&ref_topic=3399710)
17 Chromebook Language and Spellcheck [https://support.google.com/chromebook/answer/1059490?hl=en-GB](https://support.google.com/chromebook/answer/1059490?hl=en-GB)
Additional accessibility tools can be added to the Chromebook in the form of ‘apps’ or ‘extensions’ available from the Google Play Store. Some of these are free while others are priced as a one-off purchase or a subscription. CALL Scotland have created a poster listing Chromebook accessibility tools for learners with dyslexia that can be downloaded from the CALL web site.

Accessibility tools and features currently lacking in Chromebooks are:

- **MouseKeys**, to control the mouse pointer with the keyboard, available in Windows and MacOS.
- **Eye-gaze access**: eye gaze cameras cannot currently be used with Chromebooks.
- **Full access with switches**: Switch access is built into Windows, MacOS and iOS.
- **Full featured screen magnification functionality comparable to**, for example, Windows magnifiers such as **SuperNova**.

---


Use of ICT to write answers (no DQP)

Many candidates who use technology as an Assessment Arrangement in examinations utilise a word processor, perhaps with assistive support tools, to type up their answers.

This group of candidates do not require Digital Question Papers because they can access and read the standard printed question paper. They use technology to write and type their answers to alleviate physical difficulties with handwriting, or to utilise literacy support tools to address difficulties with spelling, for example.

There are also many candidates who do not have an additional support need or disability, and who choose to use ICT instead of handwriting. As devices are provide to more and more learners on a 1:1 basis, this is likely to become the largest group of candidates who use Chromebooks in examinations – provided that the devices can be managed and configured to meet the needs of the candidates; centre’s processes; and SQA’s security requirements.

Digital Answer Booklets (DABs)

SQA provide Digital Answer Booklets (DABs) for candidates to use when typing or dictating answers. SQA recommend that centres use DABs because the printed outputs can be scanned and processed electronically by the SQA e-marking system. Use of DABs is however not compulsory and candidates may use any word processor or text editor if necessary. DABs are provided in PDF and Word (.doc) format. These are supplied on the CD with the DQP or can be downloaded from www.sqa.org.uk/digitalquestionpapers.

On Chromebooks, we found that only the Microsoft Word app (Android) could access the SQA Digital Answer Booklets in .doc format.

SQA DABs in doc format

SQA provide DABs in .doc format, but these are not usable in either Google Docs or the Chromebook Office Editor - the Google word processors provided for Chromebooks - or Word Online, the online version of Word. The .doc format apps can however be accessed using the Microsoft Word Android app, if the Chromebook can run Android apps, although the file must be first upgraded and saved to the .docx format first.

With Google Docs, the instructions and text boxes required for the candidate information on the front page are either missing or appear jumbled and disjointed, and the fiducial marks at the corners of the pages are not shown at all. The text in the instructions on the front page cannot be selected and read out with a text reader.

Note that the SQA DABs in .doc format are not usable in many other word processors and text editors, such as WordPad on Windows, or Notes on iPad, either, and they are also not accessible for some candidates with additional support needs even when opened with Word on a Windows machine. For example, the DABs do not display correctly when viewed in the Word Web Layout on Windows and they are not accessible with a screen reader such as Jaws for Windows.
We believe these problems are due to the use of background images and floating text boxes on the front page, which ensure the candidate information is in the correct location for the printed booklet to be scanned by the SQA e-marking system.

It is possible that Google will develop their products to alleviate these problems with Docs; for example, in 2016 the .doc DABs would not display accurately in either Pages or Word on iPad, but by 2018 they had become functional, although not perfect. So it is possible that improvements may happen to the way in which Word files are handled by Google Docs.

Alternatively it may be possible to develop DABs that function correctly in Google Docs as well as Microsoft Word.
SQA DABs in PDF
DABs in PDF can be opened and used on Chromebooks with the apps/extensions described in the next section although the user experience with many of the tools is lacking. More details on the PDF readers discussed can be found later.

Chrome PDF Viewer
DABs in PDF can be opened with the PDF Viewer that is available on Chromebooks as standard. Answers can be typed in or dictated, saved and printed. The main limitations are that there is no AutoSave, so candidates must remember to save their answers manually as they work, and we could not get the Chrome Spellcheck to operate.

![Figure 7: Reading DQP and typing answers into a DAB with the Chrome PDF Viewer](image)

DocsPlus
DocsPlus can access a PDF DAB but we found that after typing in a few paragraphs the text cursor became misplaced so that accurate editing was impossible, and so there was a limit to how much text could be entered. There is no Autosave and the Spellcheck does not function in the DocsPlus PDF Reader.

![Figure 8: DocsPlus with PDF DAB](image)
Kami

With Kami, answers can be typed into a DAB, saved and printed. There is AutoSave and the Chrome Spellcheck operates in the DAB. However, the answer boxes are transparent, which may be disconcerting for candidates.

![Figure 9: A PDF Digital Answer Book with Kami](image)

Texthelp PDF Reader

Candidates cannot type into the answer boxes in the PDF DAB with PDF Reader. Candidates could however manually draw a text box ‘on top’, but this adds complexity and time for the user and requires accurate use of a mouse or pointing device, which is difficult or impossible for some candidates. It also risks answers not being positioned correctly – if the candidate places an answer or part of an answer outside the area of the page that is scanned by the e-marking system it will be not be seen by the marker. PDF Reader saves a new file every time the candidate saves, which generates a large number of copies of the file, and there is no Autosave facility.

![Figure 10: The Typewriter tool can draw answers 'on top' of the DAB](image)

Xodo

The Xodo web app can be used to type answers into a PDF DAB. There is no Autosave, but provided the DAB is saved the Google Drive, the users can manually save as they work through the examination. Although spelling errors are underlined in red there does not appear to be an actual spellchecker.
Spellcheck in PDF DABs

SQA provide PDF DABs in ‘spellcheck on’ and ‘spellcheck off’ variants: this helps centres to manage the use of spellcheckers when Windows computers are used, because the spellchecker in Adobe Reader on Windows computers does not function in the “spellcheck off” papers.

However, with the Chromebook PDF tools (and iPads), the spellchecker functions in both ‘spellcheck on’ and ‘spellcheck off’ PDFs. Therefore, another method is required to prevent users from accessing the spellchecker and any other literacy support tools such as AutoCorrect, word prediction and speech recognition, for the candidate’s exam account. We are not aware of a solution to this problem.

Summary

None of the options for accessing SQA Digital Answer Booklets in PDF are in our view satisfactory for use in high stakes SQA external examinations.
Digital Answer Booklets for Chromebooks

Given the issues with DABS, we created a sample DAB for Google Docs that can be downloaded from CALL’s Digital Assessment web site\textsuperscript{20}. The front page has the required information and may be edited to suit the subject and paper.

The Google Docs DAB is based on an SQA file and uses the same table structure for inserting answers. A header has been added for candidates to insert their candidate ID.

\textsuperscript{20}Adapted Digital Assessments https://www.adapteddigitalexams.org.uk/Home/
Chromebook word processors and text editors

Although the SQA DABs in PDF or .doc format are not usable, candidates could use the accessible alternative DAB with a word processor to type up their answers: for example, Google Docs, Google Forms, Microsoft Word app/online, DocsPlus or a bespoke assessment product such as ChromeEx or DigiExam.

Considerations for use in examinations are:

- security - it must be possible to prevent access to the internet and to disable spellchecking and other supports such as Automatic Substitution (AutoCorrect), if the candidate is not permitted to use them;
- candidates should not have access to dictionary, thesaurus or online look-up or research tools;
- Autosave – answers should be saved automatically;
- compatibility with accessibility tools – it should provide or allow candidates to use accessibility tools to for example read text, change colours, use screen tint overlays, or use voice typing;
- writing facilities – text editing and formatting; options for generating mathematical expressions and for drawing.

Detailed research and testing of all the available apps and extensions was beyond the scope of this small project, so we summarise the results of our research with the more common options here.
Google Docs

Google Docs (Google, 2019a) is a full featured word processor and we will not list all the tools and functions that are provided: refer to Google support online and the Docs Help for detailed information. Here we focus on features of Google Docs that are of particular relevance for learners with additional support needs who may wish to use the software as an Assessment Arrangement.

**Magnification and colour**

Candidates with visual support needs can use the zoom facility to enlarge the text. The maximum zoom with Google Docs is 200%: candidates who require larger text than this will need to use the Chrome Magnify function in the Accessibility Settings. Candidates who prefer a coloured background can alter the page colour in *File > Page Setup.*

![Figure 14: Changing page colour with Docs](image)

**Spellcheck**

To spell check, right click on a word or press Tools > Spelling or CTRL-ALT-X. The red underline of suspect words can be switched off in the settings.

![Figure 15: Google Docs Spellcheck](image)
**Voice Typing**

Voice Typing (computer dictation, or speech recognition) is available from **Tools > Voice Typing** or by pressing CTRL+AT+S. Voice Typing requires an internet connection to function. Feedback from practitioners suggests that Voice Typing is easy to use and tolerant of accents and could be of great benefit for candidates who have difficulty with typing or spelling. Learners still have to use the mouse or keyboard to edit and correct text, so it is not suitable for candidates with physical support needs who require ‘hands-free’ control. Voice Typing is not suitable for candidates with physical or motor difficulties who need to edit text or control the computer by voice, because it does not have that functionality, but feedback from practitioners suggest that it is proving to be very helpful for learners with spelling or literacy difficulties.

In the examination context, there may be security questions to be considered given that Voice Typing requires to access the internet, and that candidates’ audio responses are transmitted to a Google server (of undefined geographic location), recognised and converted into text, which is then transmitted back over the internet to the candidate’s Chromebook.

**Automatic Substitution (AutoCorrect)**

Google Docs has other tools to support writing which are found in **Tools > Preferences**. The Automatic Substitution can be helpful for candidates with spelling difficulties as it can be used to autocorrect spelling mistakes. Note that this still appears to function when the device is disconnected from the internet, so centres must ensure that candidates who do not have permission to use Spell Check cannot access it (see below).
Select and Speak
The Chrome Select and Speak text reader and ChromeVox screen reader can both be used with Google Docs. Refer to Hear text read aloud for details.

To read with Select and Speak, hold down the Search key and select the text. The text reader will read it out, highlighting each word as it reads. The voice, voice characteristics and highlight colours can be adjusted in the Accessibility Settings.

Dictionary
The Dictionary tool offers definitions. Select and speak can be used to read the definitions.

Explore
The Explore tool searches the internet for information or images.
Exam security with Google Docs

Disabling Spellcheck and literacy tools

Candidates who are not permitted to use Spell Check should not have access to it or to Voice Typing or the other writing supports. Some of these tools are disabled when the device is disconnected from the internet and so this offers a partial solution to security requirements (Table 1).

Table 1: Google Docs literacy tools offline functionality

<table>
<thead>
<tr>
<th>Google Docs Tool</th>
<th>Works Offline?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spelling and Grammar</td>
<td>No</td>
</tr>
<tr>
<td>Explore</td>
<td>No</td>
</tr>
<tr>
<td>Define / Dictionary</td>
<td>No</td>
</tr>
<tr>
<td>Voice Typing</td>
<td>No</td>
</tr>
<tr>
<td>Automatic capitalisation</td>
<td>Yes</td>
</tr>
<tr>
<td>Smart quotes</td>
<td>Yes</td>
</tr>
<tr>
<td>Automatic Substitution (correction)</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Automatic Substitution (AutoCorrect) and capitalisation still function when the device is not connected to the internet and in our tests we found that we could disable them by following this procedure:

- Connect the Chromebook to the internet and disable Automatic Substitution and Capitalisation in Tools > Preferences (Figure 21).
- Remove access to the internet.
- Automatic Substitution will not operate and the Preferences are not available, so the candidate cannot re-enable the tools.

Security for candidates who do have permission to use Spellcheck

SQA policy requires that candidates do not have access to dictionary tools, i.e. Define or Explore, so it is necessary to disable these. However, internet access is required for candidates who have permission to use Spellcheck or Voice Typing; we do not know if it is possible to enable Spell Check and/or Voice Typing but disable Define or Explore.
Saving and printing
If the devices were offline, centres would have to develop procedures to make blank DABs available on the Chromebook, and to print the completed booklets.

Figure 22: An example of a DAB with Google Forms

Microsoft Word app
An Android app version of Microsoft Word (Microsoft, 2019a) is now available from the Google Play Store and this functions on Chromebooks that can run Android apps.

The Word app works both on and offline. It has a built-in spellchecker and grammar checker that can be switched off in the software Settings but we did not find a way to disable it completely to prevent a candidate from re-enabling it. There is a Smart LookUp tool that can be disabled by disconnecting the device from the internet or preventing access to the Microsoft server. In our tests, the Chrome Select and Speak tool did not operate, nor did third party Chrome apps – presumably because Word is an Android app rather than Chrome software.

Microsoft Word Online
Word Online (Microsoft, 2019b) is the online version of Microsoft Word and is available to Scottish schools through Glow. The SQA DABs in doc format do not open correctly in Word Online, but it might be used as a straightforward word processor in an examination – provided that wider internet access can be restricted, given that it runs online. Files are opened from OneDrive and can be downloaded to the Chromebook. Changes are saved automatically. Word Online has Immersive Reader, which simplifies layout, gives control over font and colours, and a built-in text reader. Outside Immersive Reader, Chrome Select and Speak does not work, but Read&Write does. Word Online Spellcheck is part of the software, like Google Docs, and so it remains available when the Chrome spellcheck is disabled on the device. Spellcheck can be turned off in Word Online settings but candidates can easily turn it back on. We do not know if it possible to disabled it permanently.

Google Office File Editor

The Google Office File Editor\(^\text{23}\) (Google, 2019b) can open Word files (and other formats). Once the file has been saved to the Chromebook, changes are saved automatically. Some accessibility extensions functioned with it in our tests, although not Read&Write. The editor uses the built-in Chrome Spellcheck which can be turned off in Chrome Settings but not permanently.

Google Forms

Google Forms\(^\text{24}\) (Google, 2018b) is designed for surveys and quizzes and teachers are also using it for assessments. It would be possible to create a Form template with a list of blank questions for candidates to type in answers. Most of the accessibility tools function in Google Forms and TextHelp’s Equatio equation editor can also be used to generate mathematical expressions. It uses the Chrome Spellcheck which can be disabled in Chrome Settings but again the candidate could enable it and we have not found a way to successfully disable it with the Admin Console.

![Android Word app with a DAB](https://chrome.google.com/webstore/detail/office-editing-for-docs-s/gbkeegbaigmenfnjfcldgopimamgk?hl=en)

**Figure 23: Android Word app with a DAB**

DocsPlus

DocsPlus\(^\text{25}\) (Crick Software, 2019) is a word processor with literacy support tools - wordbars (word banks), word prediction, spellcheck and text reader – aimed at secondary schools. It is described in more detail in the later section on DocsPlus. It has an Exam Mode whereby the support tools can be disabled and it operates offline, so it may provide a practical solution for schools in that it offers security, accessibility and ease of administration. DocsPlus costs £30 for a single user annual subscription and £500 for a school subscription.

![DocsPlus word prediction](https://chrome.google.com/webstore/detail/office-editing-for-docs-s/gbkeegbaigmenfnjfcldgopimamgk?hl=en)

**Figure 24: DocsPlus word prediction**

\(^{23}\) Google Office Editor [https://chrome.google.com/webstore/detail/office-editing-for-docs-s/gbkeegbaigmenfnjfcldgopimamgk?hl=en](https://chrome.google.com/webstore/detail/office-editing-for-docs-s/gbkeegbaigmenfnjfcldgopimamgk?hl=en)

\(^{24}\) Google Forms [https://www.google.co.uk/forms/about/](https://www.google.co.uk/forms/about/)

\(^{25}\) DocsPlus for Chromebook [https://www.cricksoft.com/uk/docsplus/chromebook](https://www.cricksoft.com/uk/docsplus/chromebook)
Disabling Chrome Spellcheck and writing supports
A key requirement for using technology in examinations is to prevent access to the Spellcheck facility and other writing tools by candidates who do not have permission to use them. Writing tools are available in the Google Office File Editor, Google Forms, and other tools are:

- Spell check
- AutoCorrect
- Word prediction
- Auto-capitalisation
- Voice Typing / Dictation

These features are part of the Chrome operating system and can be turned off in the Chromebook Settings. However, there is nothing to prevent a candidate from switching them back on, so it is necessary for them to be disabled completely in an examination. Google state that the Spellcheck can be disabled for accounts with the Google Admin Console but in our tests, the Spellcheck was still operational even after it was disabled.

Commercial assessment platforms
There are several commercial assessment and examination systems available designed specifically for administering assessments and examinations. They have facilities to for example restrict access to the internet or to support tools such as Spellcheck. Testing all the available systems was not within the scope of this project and we summarise key aspects of some of the products here, with regard to using them for candidates who wish to use ICT as an Assessment Arrangement:

- **ChromeEx** is “for creating, administering and assessing digital exams in schools”. We do not think it is suitable for use by candidates who require Assessment Arrangements because it does not provide accessibility tools and as it runs in as a single Kiosk app, it will prevent use of accessibility tools that candidates may require such as a text reader.
- **DigiExam** is an online assessment platform for PC, Mac, Chromebook and iPad. It has accessibility features such as Spellcheck and text reader built in.
- **SurpassPaper+** is a secure word processing app designed specifically for examinations and it was piloted by SQA in 2016. SurpassPaper+ does not function on Chromebooks, only Windows and iPad.
- **WISEflow** is another online assessment platform but again the secure browser that provides security does not operate on Chromebooks.

Refer to the later section on *Technical Administration of Chromebooks in SQA examinations* for a more detailed discussion of these tools.

---

26 Set Chrome user policies [https://support.google.com/chrome/a/answer/2657289?hl=en](https://support.google.com/chrome/a/answer/2657289?hl=en)


28 DigiExam [https://www.digiexam.com/](https://www.digiexam.com/)


30 SQA renews e-Assessment contract with BTL Group, [https://www.sqa.org.uk/sqa/90399.html](https://www.sqa.org.uk/sqa/90399.html)

31 WISEflow – the digital exam platform [https://uniwise.dk/digital-exam-platform/](https://uniwise.dk/digital-exam-platform/)
### Summary of Chromebook tools for use of ICT to write answers

The table below summarises the relevant features for each of the Chromebook tools discussed in this section. ChromeEx is not included as it does not have the required accessibility tools.

**Table 2: Summary of Chromebook word processors and text editors**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Google Docs</th>
<th>Microsoft Word online</th>
<th>Microsoft Word Android app</th>
<th>Google Office File Editor</th>
<th>Google Forms</th>
<th>DocsPlus</th>
<th>DigiExam</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost</td>
<td>Free</td>
<td>Free</td>
<td>Free</td>
<td>Free</td>
<td>Free</td>
<td>Annual subscription: £30 single user; £500 school licence</td>
<td>Contact DigiExam</td>
</tr>
<tr>
<td>Access .doc DABs</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>AutoSave</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Change colours</td>
<td>Yes</td>
<td>Yes – in Immersive Reader</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Not known</td>
</tr>
<tr>
<td>Text reader</td>
<td>Select and Speak</td>
<td>Yes – in Immersive Reader</td>
<td>No</td>
<td>Select and Speak</td>
<td>Select and Speak</td>
<td>DocsPlus &amp; Select and Speak</td>
<td>DigiExam</td>
</tr>
<tr>
<td>Spellcheck</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes (Chrome)</td>
<td>Yes (Chrome)</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Disable Spellcheck</td>
<td>Yes - disconnect internet.</td>
<td>Disable in Settings, but not permanently</td>
<td>Disable in Settings, but not permanently</td>
<td>Disable in Chrome settings (not permanently)</td>
<td>Disable in Chrome settings (not permanently)</td>
<td>Yes – Exam Mode</td>
<td>Yes</td>
</tr>
<tr>
<td>Other Literacy Support</td>
<td>AutoCorrect, prediction, Define, Explore.</td>
<td>Immersive Reader, AutoCorrect, Grammar, Translate</td>
<td>Grammar, Translate</td>
<td>No</td>
<td>No</td>
<td>Word banks, prediction</td>
<td>Not known</td>
</tr>
<tr>
<td>Disable other literacy supports</td>
<td>We do not know if Define/Explore can be disabled when Spellcheck is enabled.</td>
<td>No</td>
<td>Disable Grammar in Settings. Disconnect internet to stop LookUp.</td>
<td>N/A</td>
<td>N/A</td>
<td>Yes – Exam Mode</td>
<td>N/A</td>
</tr>
<tr>
<td>Computer dictation</td>
<td>Yes – Google Dictation</td>
<td>Yes – MS Dictate &amp; Google Dictation</td>
<td>Yes – Google Dictation</td>
<td>Yes – Google Dictation</td>
<td>Yes – Google Dictation</td>
<td>Yes – Google Dictation</td>
<td>Not known</td>
</tr>
</tbody>
</table>
None of the tools reviewed offer all the desired features in terms of accessibility, literacy support, drawing and maths, and examination security and so centres may choose one or more that best meets the needs of the students.

**Candidates who do not have permission to use Spellcheck**

Candidates who do not have permission to use Spellcheck or other supports could use *Google Docs* to type up examinations by disconnecting the Chromebook from the internet: this disables the spelling and literacy tools.

*Google Editor* and *Forms* may be suitable for candidates but the built-in Chrome Spellcheck cannot as far as we know be disabled completely. Centres will therefore have to disable the Spellcheck and other literacy tools in the device Settings and adopt invigilation procedures to ensure that candidates do not turn them back on.

*DocsPlus* is option, offering literacy and accessibility tools that can be disabled in Exam Mode but does not offer drawing tools or an equation editor.

Of the commercial assessment systems, *DigiExam* may offer a solution as it provides both security, accessibility, drawing and an equation editor.

**Candidates who do have permission to use Spellcheck**

Candidates who have permission to use Spellcheck and other writing supports could use *Google Forms* and *Google Editor*.

*Google Docs* is not suitable for candidates who use Spellcheck because the Google Docs Spellcheck requires internet access which then also allows access to the *Define* and *Explore* features that are not permitted. We do not know if these tools can be disabled while leaving Spellcheck and Automatic Substitution enabled.

*DocsPlus* provides many of the desirable tools and security options, while *DigiExam* provides security, accessibility, drawing and an equation editor.
Digital Question Papers

Background
Digital Question Papers are digital versions of the question paper. They are provided by SQA for candidates who have difficulty accessing, reading or interacting with the standard hard copy papers (Scottish Qualifications Authority, 2017a).

Digital Question Papers (DQPs) were first offered as an Assessment Arrangement by SQA in 2008, following development, evaluation and pilot projects undertaken by CALL and SQA (Nisbet, Aitken and Shearer, 2004; Nisbet et al., 2006; Nisbet, 2007, 2009). The DQPs are PDF files. PDF was chosen because:

- The trials and pilots had shown that the PDF DQPs were accessible for the majority (but not all) of candidates who require assessment arrangements.
- The Digital Papers could be made interactive, so that candidates can type and draw answers on screen. The research indicated that this was an important feature for candidates.
- PDF was a cross-platform and proven reliable file format.
- Adobe Reader software for accessing PDFs was installed as standard on all school computers.
- Staff and learners were therefore generally familiar with the software.
- Internet provision in schools was in 2008 inadequate to support reliable online delivery of examinations, and PDF was a suitable format for delivery on CD.
- Production costs to SQA were very low, as PDFs of papers were produced already as part of the existing production process.

DQPs were developed to complement the existing Assessment Arrangements, including for example papers in Large Print or Braille; use of human readers or scribes; use of a word processor; etc. The PDF DQPs are not suitable for every candidate and every subject: for example, the standard SQA DQPs are not optimised for candidates with significant visual impairment who use screen reading technology. In addition, because the examinations are designed to be accessed on paper, some questions do not particularly suit the digital medium: mathematical and scientific formulae cannot be read out by a computer reader, while options for candidates to generate mathematical formulae using technology do exist, but are very limited with the DQP PDF files.

Digital Question Papers are produced by SQA in two styles:

- ‘Question and Answer’ Digital Question Papers with ‘answer boxes’ for candidates to type answers on-screen. These papers are digital versions of the paper booklets which have space provided for candidates to handwrite answers on the paper.
- ‘Question Only’ papers that do not have answer boxes. Candidates can use this type of DQP to read the questions, and to record answers, a candidate uses a word processor and/or a Digital Answer Booklet (DAB). DABs are digital versions of the paper answer booklets. DABs are provided by SQA in PDF and Word format.
Digital past papers for the past five years can be downloaded from SQA’s web site [www.sqa.org.uk/digitalquestionpapers](http://www.sqa.org.uk/digitalquestionpapers) for revision and practice.
Accessibility features of SQA Digital question papers on Windows OS

SQA DQPs accessed using a standard Windows computer using the free Adobe Reader software have a number of helpful accessibility features (Scottish Qualifications Authority, 2016a). These features have proven to be beneficial for candidates over the 10 years since DQPs were introduced and similar functionalities are therefore required when using Chromebooks or other devices. Before we turn to how Chromebooks can be used to access DQPs we summarise the current technology available on Windows. These features form a specification for testing Chromebooks and Chromebook apps and extensions for accessing Digital Question Papers.

Opening and saving DQPs and DABs

SQA currently deliver DQPs on CD as PDF files. Centres then distribute the files to candidates either via secure network, or install from the CD, or via a USB stick. On Windows, candidates typically double click to open the DQP in Adobe Reader. The paper can be saved to any file location. Adobe Reader has an auto-save feature to save candidates’ answers.

Zoom / magnify

Candidates with a visual impairment can zoom in to magnify the questions. Question-only papers can be ‘re-flowed’ to fit the screen area. Two pages can be viewed side-by-side.

Colours

Background and foreground colours can be set for candidates who need a high contrast, or for students with visual stress who may require a specific background colour (Wilkins et al., 2001; Kriss and Evans, 2005; Rello and Bigham, 2017).

Text Readers

Text to speech is one of the most useful and empowering accessibility tools. Text to speech enhances student choice, differentiation and self-advocacy (Parr, 2011), can improve reading comprehension (Lange et al., 2006; Floyd and Judge, 2012; Park et al., 2017; Wood et al., 2017) and proficiency (Park et al., 2017) for learners with reading difficulties.
SQA create digital papers so that any text that is necessary to access to answer the question can be selected and read out using a computer text reader. Computer text readers for Windows computers are available at zero cost to schools, or in the form of commercial Literacy Support software (see CALL Scotland’s Text to Speech web pages\textsuperscript{32}). On Windows and MacOS, candidates have the option of reading with two high quality Scottish accent computer voices, and a Scottish Gaelic computer voice, which can be downloaded and installed on Windows school computers free of charge from CALL Scotland’s Scottish Voice web site\textsuperscript{33}. The combination of free text reader and computer voices provides centres with high quality accessibility provision at zero purchase cost.

### Screen Readers

Screen readers such as Jaws or NVDA on Windows, VoiceOver for MacOS and iOS, and ChromeVox for Chromebooks, are designed for people who cannot see, and who require everything on the device to be read out. Screen readers provide information about what is on screen, where it is, and what it is. Current DQPs produced by SQA are not optimised for candidates who use screen readers (Nisbet and Aitken, 2017).

### Navigation

SQA designers add ‘bookmarks’ to DQPs so that candidates can quickly navigate around the paper. Candidates can also navigate using page thumbnails. Candidates can move between pages with keyboard, mouse or scrollbar or touch screen.

### Answer boxes and interaction

An important aspect of the ‘question and answer’ DQPs is the facility to type or dictate answers into an answer box in the question paper and draw and annotate on screen. Drawing on-screen is not used by many candidates, according to the responses to annual SQA surveys - most candidates use the paper copy and draw by hand - but it is an important option for students with physical support needs who cannot hold or manipulate manual pens or drawing implements.

![Figure 29: DQP showing coloured background, computer text reader, navigation bookmarks, and answer boxes](image)

\textsuperscript{32} Text-to-speech, \url{http://www.callscotland.org.uk/information/text-to-speech/}
\textsuperscript{33} Scottish Computer Voices \url{http://www.thescottishvoice.org.uk/home/}
Physical support needs

Candidates who cannot use a physical keyboard can type with an on-screen keyboard accessed using a mouse, joystick, switches or eye gaze camera. Candidates can use the free on-screen keyboard provided in Windows or a third-party package with specific features.

For example, Tobii eye gaze cameras would be used with the Tobii Windows Control software\textsuperscript{34} and keyboard; while a candidate who uses a switch, eye gaze or pointing device might use Grid 3\textsuperscript{35} to access the papers and generate responses. Tools like Grid 3 offer more efficient computer control, the option to create on-screen keyboards optimised for the user and the subject, and speech output for communication.

Candidates who cannot use a mouse or other pointing device can navigate the paper and type answers using keyboard shortcuts.

\textsuperscript{34} Tobii Windows Control. \url{https://www.tobiidynavox.com/en-gb/software/windows-software/windows-control-software/}

\textsuperscript{35} SmartBox Grid 3 \url{https://thinksmartbox.com/product/grid-3/}
Spellcheckers and literacy support tools
SQA’s policy is that spellcheckers cannot be used in examinations unless the candidate has an identified spelling difficulty which places them at a substantial disadvantage for the particular examination and a request to use spellcheck has been made and permission received using the SQA AAR online system (Scottish Qualifications Authority, 2016b).

To support centres to manage access to spellcheckers in the examination, SQA provide two versions of each DQP: one paper that is ‘spellcheck enabled’, where the Adobe Reader spellchecker will function, and a second paper where the spellchecker is not enabled. Centres provide the spellcheck-enabled papers to candidates who have permission to use the spellchecker, and the spellcheck-disabled papers to candidates who do not have permission to use a spellchecker.

Other writing supports such as dictation, AutoCorrect and word prediction are becoming available as standard on devices and word processors including Chromebooks and so centres will require a means to disable access to these tools when using interactive Digital Question Papers.

Mathematics and science
The answer boxes in SQA maths and science DQPs are RTF (Rich Text Formatted) fields, which allow the use of bold, italics, underlines and super/sub scripts in Adobe Reader for Windows.

Simple mathematical expressions can be typed into the DQP, but more complex algebraic equations cannot be realistically entered, while drawing graphs and charts is not practical with the basic Adobe Reader drawing tools. For Windows OS, CALL Scotland therefore recommends (CALL Scotland, 2015) use of a specialist equation editor and/or drawing program such as FX Draw\(^\text{36}\).

Similarly, while simple diagrams can be created with the Adobe Reader annotation tools, more complex diagrams such as graphs, pie charts, sketches, circuit diagrams and technical drawings will typically require more specialist maths, drawing or CAD software.
Accessing DQPs and PDF DABs with Chromebooks

There are many Chromebook apps and extensions available that can open and access PDFs and it was impossible to research every one. Instead, we reviewed and then tested the most promising apps/extensions following internet research and discussions with colleagues in local authorities and Google. The results of tests with Chrome PDF Viewer, DocsPlus, Kami, Snap&Read, Texthelp PDF Reader and Xodo are given in this report.

We anticipate that this information will be updated as the apps and extensions are developed, and as new products appear on the market.
Question Only Digital Question Papers
As noted previously, around half of the SQA digital papers are ‘Question Only’ where a candidate may read the paper on screen and type answers using a separate digital answer booklet or word processor. All of the apps and extensions reviewed here can be used to access a Question Only DQP.

Relevant factors and considerations for PDF readers for DQPs are:

- Ability to view DQP and answers side by side.
- View and zoom options.
- Colour adjustment or overlays.
- Text reader functionality.
- Keyboard only and mouse-only access.
- Offline use (so that the device can be disconnected from the internet for security).

Tools for accessing Question Only DQPs

<table>
<thead>
<tr>
<th></th>
<th>Chrome PDF Viewer</th>
<th>DocsPlus</th>
<th>Kami for Schools</th>
<th>Snap&amp;Read universal</th>
<th>Texthelp PDF Reader</th>
<th>Xodo</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View DQP and DAB side by side</strong></td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Zoom / magnify</strong></td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Change colours</strong></td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes – but the colour overlay did not work in our tests; the line ruler did.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td><strong>Read with computer text reader</strong></td>
<td>Yes, Chrome Select and Speak.</td>
<td>Yes – use the DocsPlus reader or Select and Speak.</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes – a text reader is built in. There is also a ScreenShot Reader.</td>
<td>No</td>
</tr>
<tr>
<td><strong>Scottish computer voices</strong></td>
<td>Yes, by buying Acapela’s Rhona voice</td>
<td>Yes, by buying Acapela’s Rhona voice and using Select and Speak.</td>
<td>Yes, by buying Acapela’s Rhona voice.</td>
<td>Yes, by buying Acapela’s Rhona voice.</td>
<td>Yes – Fion (Vocaliser) is available in Read&amp;Write, and Acapela’s Rhona voice will also work if it has been purchased and installed.</td>
<td>No</td>
</tr>
<tr>
<td><strong>Keyboard only access</strong></td>
<td>Good</td>
<td>Limited</td>
<td>Good</td>
<td>Limited</td>
<td>Limited</td>
<td>Good</td>
</tr>
<tr>
<td><strong>Offline use</strong></td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Of the apps reviewed, centres might consider:

- *Chrome PDF Viewer*;
- *Kami for Schools*;
- *Texthelp PDF Reader*;

as they enable the DQP to be viewed alongside the candidate’s answers, and a text reader can be used to read the questions.

**Viewing DQP and answers side by side**

Accessing a DQP with a separate word processor for answers requires the candidate to use two windows, apps or extensions and arrange them on screen side by side on screen or swap between the windows.

Figure 35 illustrates the use of TextHelp PDF Reader to read the questions with text-to-speech, together with Google Docs to type the answers.

![Figure 35: Reading a DQP with TextHelp PDF Reader and typing answers with Google Docs](image)

To arrange the two windows on screen, drag one tab to a separate location, click and hold on the **Maximise** button until you see the two horizontal arrows, then choose either the left or right arrow to dock the window. Drag and re-size the windows manually if you want to see them on top and bottom of the screen.

![Figure 36: DQP and DAB in PDF accessed with Xodo](image)
Question and Answer Digital Question Papers

Question and Answer DQPs have answer boxes where candidates can type or dictate text and can also use drawing and annotation tools to interact with the assessment.

Of the PDF readers tested, *Chrome PDF Viewer, DocsPlus, Kami and Xodo* can be used to type answers into the on-screen fields.

![Figure 37: Typing into answer boxes with Chrome PDF Viewer](image)

*Snap&Read* and *Texthelp PDF Reader* cannot type text into the answer boxes, although it is possible to insert a text comment ‘on top’ of the PDF.

Relevant features and considerations for accessing Question and Answer PDFs are:

- Autosave;
- Printing;
- Access to answer boxes;
- Text reader functionality;
- Spellcheck and literacy support tools – whether they are provided, and if they can be disabled for candidates for whom literacy support is not permitted.

Tools for accessing Question and Answer DQPs

*Table 4: Chromebook tools for Question and Answer DQPs*

<table>
<thead>
<tr>
<th>Feature</th>
<th>Chrome PDF Viewer</th>
<th>DocsPlus</th>
<th>Kami for Schools</th>
<th>Snap&amp;Read universal</th>
<th>Texthelp PDF Reader</th>
<th>Xodo</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cost</strong></td>
<td>Free</td>
<td>Annual subscription: £30 single user; £500 school licence</td>
<td>Contact Kami.</td>
<td>$3.99/month for a personal licence (credit card only)</td>
<td>Annual subscription: £150 single user; from £800 school.</td>
<td>Free</td>
</tr>
<tr>
<td><strong>Autosave DQP</strong></td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td><strong>Printing</strong></td>
<td>Yes</td>
<td>No, for a DQP</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Feature</td>
<td>Chrome PDF Viewer</td>
<td>DocsPlus</td>
<td>Kami for Schools</td>
<td>Snap&amp;Read universal</td>
<td>Texthelp PDF Reader</td>
<td>Xodo</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------</td>
<td>----------</td>
<td>------------------</td>
<td>----------------------</td>
<td>---------------------</td>
<td>------</td>
</tr>
<tr>
<td><strong>Type into answer boxes</strong></td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No. Use the Text tool to type ‘on top’ of the answer box.</td>
<td>No. Use the Typewriter to type on top.</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Read with computer text reader</strong></td>
<td>Yes, Chrome Select and Speak.</td>
<td>Yes – use the DocsPlus reader or Select and Speak.</td>
<td>Yes</td>
<td>Yes – a text reader is built in. There is also a ScreenShot Reader.</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td><strong>Spellchecker</strong></td>
<td>No.</td>
<td>Yes (DocsPlus)</td>
<td>Yes (Chrome Spellcheck)</td>
<td>Yes (Chrome Spellcheck)</td>
<td>Yes (Chrome Spellcheck)</td>
<td>No</td>
</tr>
<tr>
<td><strong>Literacy supports</strong></td>
<td>No.</td>
<td>Word prediction, word banks.</td>
<td>Dictionary / Lookup (internet required)</td>
<td>Highlight and collect text from the paper to an outline. Define, Simplify Text, Translate tools.</td>
<td>Word prediction, Picture Dictionary, Online Dictionary, highlighter to collect notes and quotes, translator</td>
<td>No</td>
</tr>
<tr>
<td><strong>Exam Mode / disable Spellcheck and writing supports</strong></td>
<td>N/A</td>
<td>Yes</td>
<td>No</td>
<td>no</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td><strong>Offline use</strong></td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Only DocsPlus and Kami provide an Autosave function, which we think is essential for examinations. However, DocsPlus appears to limit the amount of text that can be typed into an answer box, while the user experience with Kami’s answer boxes is not satisfactory and we could not find a mechanism for disabling the Spellcheck securely.

Therefore we do not recommend any of these tools for accessing Question and Answer Digital Papers.
Chrome PDF Viewer

Summary

SQA DQPs can be opened and viewed using the Chrome Online Viewer when PDFs are opened in the browser, and a separate Offline PDF Viewer which can be used for files downloaded to the Chromebook. The online browser is not suitable for DQPs because answers cannot be typed in, and in our tests the Chrome Select and Speak text reader was not reliable.

The offline PDF Viewer may be suitable for question-only DQPs: the DQPs can be magnified and zoomed, and the Select and Speak can read the questions. With the offline Viewer, answers can be typed into Question and Answer DQPs and saved, but the lack of Autosave or Spellcheck means it is not ideal for examinations.

Pricing

Free, built into Chromebooks.

Question Only Digital Question Papers

When a DQP is opened on a Chromebook from Google Drive it is initially displayed using the Online browser-based PDF Viewer. This can be used to view the DQP and the PDF can be zoomed to enlarge the text and so it may be suitable for candidates who need a basic PDF viewer to access a digital paper. However, we found the Chrome Select and Speak text reader to be unreliable - sometimes it worked, and sometimes it didn’t - and when it did it spoke out the document title before the text each time it spoke, which was confusing.

By downloading the DQP to the device itself, it can be opened with the PDF Viewer. Select and Speak seemed to be more reliable and this Viewer can also access the bookmarks for navigating the paper.

![Figure 38: Reading with Chrome Select and Speak](image)

Question and Answer Digital Question Papers

Answers can be typed into boxes with the Offline Viewer and the file can be saved. However, there is no AutoSave which we think is essential for use in examinations. Mis-spellings are underlined, but there is no actual Spellcheck so the PDF Viewer may be suitable for candidates who do not have permission to use Spellcheck, but it is not suitable for those who require it.
Examination arrangements

There are no settings for administering examinations. PDF Viewer can run without an internet connection so that is one measure that could be used to address security concerns.
DocsPlus

Summary

**DocsPlus** (Crick Software, 2019) is a literacy support app designed for secondary schools. It is available on Windows, Mac and Chromebooks. DocsPlus provides a Document window for typing answers, and a DocReader window that can read and access DQPs. It has good tools to support reading and writing and they can be disabled if not required using an Exam Mode. The literacy tools are:

- wordbars (word banks);
- word prediction;
- Spellcheck;
- text reader.

![Figure 40: DocsPlus word prediction](image)

DocsPlus is a good solution for candidates who wish to use technology for typing answers, and the Exam Mode eases administration. Question-only DQPs can be viewed and read with text-to-speech but inability to view question paper and answers side by side may be problematic for some candidates. We do not recommend it for Question and Answer DQPs because the paper cannot be printed directly from the app.

**Pricing**

DocsPlus for Chromebook costs £30 for a single user 1 year subscription and £500 for a 1 year site license.

**Question Only Digital Question Papers**

Candidates can access DQPs with the DocReader and use the text reader to read the questions. Limitations are that colours cannot be adjusted and the choice of voices is limited and does not include Scottish accents. Users cannot view both a DQP and their answers in a document at the same time.
Question and Answer Digital Question Papers

Candidates can type answers into answer boxes in the DQP and the literacy tools work well. However, the font size for the answer boxes seems large and the amount of text that can be typed is therefore relatively small. In our tests there seemed to be a limit on the amount of text – between 250 and 450 characters - that could be typed into PDF DABs beyond which the text cursor was not in the correct location and editing was virtually impossible. The paper cannot be printed directly from within the app, and we found that answers were not formatted correctly when opened in other PDF readers in order to print.

Examination arrangements

DocsPlus has an Exam Mode which is easy to use and allows all the support tools to be switched off individually. It does not require internet to function.

More Information

- DocsPlus app for Chromebook
- Using DocsPlus in exams
- Reviews and success stories
Kami for Schools

Summary

Kami (Kami, 2019) is a Chrome app and extension for reading and annotating PDF files. It is available in Basic and Premium for Schools versions. Basic is not suitable for use in examinations because it does not have text-to-speech, does not Autosave answers and has adverts. The Premium (subscription) Kami has good features for reading question-only DQPs and some helpful facilities for accessing Question and Answer DQPs (e.g. AutoSave) but the user experience with answer boxes is not the best.

Pricing

Basic is free and lets you open and read the DQP and/or DAB in PDF format. The Premium Teacher Plan is $99 per teacher/class per year and there are licencing arrangements for Kami for Schools.

Question Only Digital Question Papers

DQPs can be opened, viewed and read with the built-in text reader. There is zoom but colours cannot be adjusted.

![Reading with Kami Text to Speech](image)

Question and Answer Digital Question Papers

Candidates can type into answer boxes, although they are transparent so any handwriting guides are visible which may be distracting, particularly when Kami is used to access a Digital Answer Book in PDF.

There are a good range of drawing and annotation tools and an equation editor. The Chrome Spellcheck functions in both ‘spellcheck on’ and ‘off’ DQP and PDF DABs.
Examination arrangements

There is no exam mode. Kami can work offline, which may make administration easier to organise. The built in Chrome Spellcheck can be disabled in the Chrome Settings, but not permanently.

More Information

- Kami
- Kami pricing
Snap&Read

Summary
Snap&Read (Don Johnston, 2019) is an extension designed for improving access to web sites and documents and it can also view and annotate PDFs. Candidates who wish to read question-only DQPs may find it helpful: it has a good text reader, a Screenshot reader, and other reading and study tools. Answers cannot be typed into answer boxes and there is no Autosave so we do not recommend it for Question and Answer DQPs. We have been informed by Don Johnston, the US suppliers, that as of May 2018 school or organisational licences are no longer sold in the UK or the European Union as a result of difficulties with GDPR compliance. It is still available in the Google Play store.

Pricing
$3.99/month for a personal licence (credit card only).

Question Only Digital Question Papers
Snap&Read has good tools for reading and accessing DQPs although some of the supports (e.g. Define) are not permitted in an examination.

[Figure 45: Snap&Read text reader]

Question and Answer Digital Question Papers
Users cannot type into answer boxes, but candidates can click and type answers ‘on top’ of the PDF. However, there is no AutoSave and each time the DQP is saved, a new file is created, which is likely to be confusing for candidates.

Examination arrangements
We think that Snap&Read can be configured to enable or disable access to different support tools but have not been able to confirm this. In our tests Snap&Read did not function unless it was connected to the internet.

More Information
- Snap&Read https://learningtools.donjohnston.com/product/snap-read/
Texthelp PDF Reader

Summary

PDF Reader (Texthelp, 2019) is part of Texthelp’s Read&Write for Google Chrome extension. Read&Write is a long-established literacy support package with versions available for Windows, Mac, Android and iPad as well as Chrome.

The free version of PDF Reader can view a DQP and read the questions with text-to-speech and so PDF Reader is a good option for accessing question-only DQPs. Typing and interacting with DQPs requires the Premium version but the lack of Autosave and inability to type into answer boxes means that we do not recommend it for Question and Answer DQPs.

Pricing

Premium costs £150 for an annual subscription for a single user and from £800 for an annual subscription for a school. Local authority site licences are also available. Teachers can get free access to the Premium version.

Question Only Digital Question Papers

Candidates can access Question Only DQPs using both free and premium versions of Texthelp PDF Reader. PDF Reader provides zoom and colour screen masking tools. The ‘Click to Speak’ text reader works well and there is also a ‘Screenshot Reader’ (Premium only) where the candidate can draw an area around the text to be read. There are dictionary and picture dictionary and highlighting tools for marking and collating quotes and references from the DQP.

Question and Answer Digital Question Papers

Candidates cannot type into answer boxes, but the ‘Typewriter’ tool can be used to type ‘on top’ of the PDF. This requires the candidate to draw answer boxes manually using the mouse or trackpad, which some candidates will find difficult or impossible. It is also possible that candidates could type answers outside the area of the file that will be scanned by the e-Marking system, and therefore...
lose marks. A new copy of the DQP is saved every time the Save button is clicked, so candidates will generate multiple files which may be confusing.

The typewriter in PDF Reader has helpful tools for supporting writing, including spellchecker, word prediction and voice typing. They cannot be turned off and so PDF Reader is not suitable for candidates for whom literacy support is not permitted.

TextHelp’s Equatio equation editor can be used to write equations and mathematic expressions into DQPs: a premium subscription is required. There are no drawing tools provided.

**Examination arrangements**

PDF Reader does not have an exam mode. The writing supports in the Typewriter cannot be turned off and so PDF Reader is not suitable for candidates for whom literacy support is not permitted. In our tests Snap&Read did not function unless it was connected to the internet.

However, Texthelp also offer Read&Write for Assessments\(^{37}\). This appears to be a simple text editor where accessibility features such as Spellcheck, text-to-speech and word prediction can be enabled as required. Texthelp suggest that it should be applied in Kiosk Mode which allows only one app to run; therefore they suggest that one Chromebook is provided to read the DQP and a second to write responses: “for students that require IEP accommodations for writing, they’ll need a secondary device with a secure writing environment that includes necessary accommodations like text-to-speech, word prediction and Talk&Type”.

**More Information**

- PDF Reader
- Read&Write for Google Chrome
- Pricing
- Make your PDFs accessible and collaborative Webinar
- Transform PDFs with the Texthelp PDF Reader
- Why Stop with G Suite and Microsoft Word? Type Math in PDFs Too!

---

XODO PDF Viewer and Editor

Summary

Xodo (Xodo, 2019) is a web app and a downloadable app which can run offline. Xodo provides core functions for reading and accessing SQA DQPs and PDF DABs – candidates can view the question papers, type into answer boxes, draw and annotate. However, there is no text reader built in and we could not get other text readers to work; and there is no Spellcheck and no Autosave. It may suit the needs of some candidates but has significant limitations for candidates who use Assessment Arrangements.

Pricing

Xodo is free for personal use.

Question Only Digital Question Papers

Xodo is effective for opening and viewing DQPs but there is no text-to-speech provided and text reader extensions that we tested such as ClaroRead and Read&Write did not function either. There may also be other text readers that do work with Xodo that we have not been able to find. The Xodo Android app is claimed to have a text reader, so this may be an option if your Chromebook can run Android apps.

Question and Answer Digital Question Papers

Xodo gives an effective experience for typing into answer boxes. However, there is no Spellcheck so it is not suitable for candidates who need spelling support. There is also no Autosave, although candidates can manually save to Google Drive or to the Chromebook itself.

Examination arrangements

The downloadable Xodo app can run offline if internet access is not available. Files can be loaded from Google Drive or from the device itself. There are no options to turn off Spellcheck (since there is no Spellcheck).

More Information

- Xodo
Text to speech voices for Chromebooks

Chrome voices

Chromebooks have built-in text to speech tools in the form of Select and Speak and ChromeVox; both can be used to read DQPs with the PDF viewers we tested apart from Xodo. Chrome (at time of writing in August 2019) offers three UK English voices and a large number of other languages but a Scottish voice is not available.

Acapela Chrome voices

Voices from Acapela are now available for Chromebooks, including the Scottish Rhona voice. The Acapela voices cost around £6 for an individual Google account. We do not know if school or domain licences are available.

To purchase Rhona, download the Acapela Speech Engine from the Chrome Store and buy the voice, then set it to be the default voice for the device. The voice can then used by Select and Speak and the other Chrome text to speech tools.

CereProc Android Voices

The Scottish CereProc voices are available for Android for 59p each, and this means they can be installed on those Chromebooks that can run Android apps. Unfortunately, the CereProc voices do not seem to work with any of the Chrome apps or extensions.

---

38 Acapela voices for Chromebooks [https://www.acapela-group.com/solutions/acapela-voices-for-chromebooks/](https://www.acapela-group.com/solutions/acapela-voices-for-chromebooks/)

# Comparison of apps/extensions for accessing Digital Question Papers on Chromebooks

Table 5: Chromebook apps and extensions for SQA Digital Question Papers and PDF Digital Answer Booklets

<table>
<thead>
<tr>
<th>Feature</th>
<th>Chrome PDF Viewer</th>
<th>DocsPlus</th>
<th>Kami for Schools</th>
<th>Snap&amp;Read universal</th>
<th>Texthelp PDF Reader</th>
<th>Xodo</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cost</strong></td>
<td>Free</td>
<td>Annual subscription: £30 single user; £500 school licence</td>
<td>Contact Kami.</td>
<td>$3.99/month for a personal licence (credit card only)</td>
<td>Annual subscription: £150 single user; from £800 school.</td>
<td>Free</td>
</tr>
<tr>
<td><strong>Open DQP</strong></td>
<td>Open from Google Drive or device</td>
<td>Open from Google Drive or device</td>
<td>Open from Google Drive or device</td>
<td>Open from Google Drive, OneDrive or device</td>
<td>Open from Google Drive or device</td>
<td>Open from Google Drive or device</td>
</tr>
<tr>
<td><strong>Save DQP</strong></td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes to the device; a new file created for each save.</td>
<td>Yes, a new file created for each save.</td>
<td>Yes, a new file created for each save unless manually renamed.</td>
</tr>
<tr>
<td><strong>Autosave DQP</strong></td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td><strong>Open PDF DABs</strong></td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Open .doc DABs</strong></td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No (use Docs and Snap&amp;Read)</td>
<td>No (use Docs and Read&amp;Write)</td>
<td>No</td>
</tr>
<tr>
<td><strong>View DQP and DAB side by side</strong></td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Printing</strong></td>
<td>Yes</td>
<td>No, for a DQP</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Copy candidate</strong></td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>Chromebooks for SQA Assessment Arrangements Revised 7/1/20</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------------</td>
<td>-----------------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>ID on each page</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Zoom / magnify</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reflow</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Navigate with bookmarks and page thumbnails</td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page turn / scroll</td>
<td>Touch; mouse; scroll bar; keyboard.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Touch; mouse; scroll bar; keyboard.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Touch; mouse; scroll bar; keyboard.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Touch; mouse; scroll bar; keyboard.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Change colours</td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes - the colour overlay did not work in our tests; the line ruler did.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>No</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Read with computer text reader</strong></td>
<td>Yes, Chrome Select and Speak.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes – use the DocsPlus reader or Select and Speak.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes – a text reader is built in. There is also a ScreenShot Reader.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Voices available</td>
<td>Chrome voices including UK female voice.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5 with DocsPlus, many more with Select and Speak.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Chrome voices including UK female voice.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Chrome voices including UK female voice.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>US and UK voices Daniel and Serena.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scottish computer voices</td>
<td>Yes, by buying Acapela’s Rhona voice.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes, by buying Acapela’s Rhona voice.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes, by buying Acapela’s Rhona voice.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Yes – Fiona (Vocaliser) is available in Read&amp;Write,</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Rhona voice and using Select and Speak.</td>
<td>and Acapela’s Rhona voice will also work if it has been purchased and installed.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------------------------</td>
<td>---------------------------------------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modern Foreign Language voices</td>
<td>Yes, many available from Chrome.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keyboard only access</td>
<td>Good - Space and arrow keys; TAB between answer boxes.</td>
<td>TAB between answer boxes but the keyboard cannot be used to move from page to page in the DocReader - candidates have to tap or click buttons.</td>
<td>Good – keyboard shortcuts for annotations. Space; arrow keys to navigate. TAB to move between answer boxes.</td>
<td>Limited – Space; arrow keys to navigate. You cannot TAB between answer boxes.</td>
<td>Limited – Space; arrow keys to navigate. You cannot TAB between answer boxes.</td>
<td>Good – Xodo has keyboard shortcuts for annotations. Space; arrow keys to navigate. TAB to move between answer boxes.</td>
</tr>
<tr>
<td>Mouse only access</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Type into answer boxes</td>
<td>Yes</td>
<td>yes</td>
<td>Yes</td>
<td>No. Use the Text tool to type ‘on top’ of the answer box.</td>
<td>No. Use the Typewriter to type on top.</td>
<td>Yes</td>
</tr>
<tr>
<td>Tick boxes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No – draw or type a letter</td>
<td>No – draw or type a letter.</td>
<td>Yes</td>
</tr>
<tr>
<td>Drawing tools</td>
<td>Yes. Freehand.</td>
<td>no</td>
<td>Yes. Freehand; line; rectangle; circle.</td>
<td>Yes. Line.</td>
<td>Yes. Freehand drawing; draw square, circle, line, arrowed line, connected line, polygon, cloud.</td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Google Docs</td>
<td>DocsPlus</td>
<td>Chrome Spellcheck</td>
<td>Chrome Spellcheck</td>
<td>DocsPlus</td>
<td>Chrome Spellcheck</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------</td>
<td>----------</td>
<td>-------------------</td>
<td>-------------------</td>
<td>----------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Annotation tools</td>
<td>No</td>
<td>no</td>
<td>Text, audio and video comment; text box; highlight; underline; strikethrough.</td>
<td>Yes – highlight box.</td>
<td>Text comments, audio comments, highlighters.</td>
<td>Yes. Highlighter; strikethrough; underline; insert note, insert image.</td>
</tr>
<tr>
<td>Spellchecker</td>
<td>No.</td>
<td>Yes (DocsPlus)</td>
<td>Yes (Chrome Spellcheck)</td>
<td>Yes (Chrome Spellcheck)</td>
<td>Yes (Chrome Spellcheck)</td>
<td>No</td>
</tr>
<tr>
<td>Literacy supports</td>
<td>No.</td>
<td>Word prediction, word banks.</td>
<td>Dictionary / Lookup (internet required)</td>
<td>Highlight and collect text from the paper to an outline. Define, Simplify Text, Translate tools.</td>
<td>Word prediction, Picture Dictionary, Online Dictionary, highlighter to collect notes and quotes, translator</td>
<td></td>
</tr>
<tr>
<td>Computer dictation</td>
<td>Yes, Google Dictation.</td>
<td>Yes, Google Dictation.</td>
<td>Yes, Google Dictation.</td>
<td>Yes - you can dictate into a Text Box.</td>
<td>Yes, you can dictate into a Text Box.</td>
<td>Yes, Google Dictation.</td>
</tr>
<tr>
<td>Insert maths &amp; science expressions</td>
<td>No.</td>
<td>No</td>
<td>Yes – equation editor.</td>
<td>No</td>
<td>Yes, Texthelp’s Equatio equation editor.</td>
<td>No</td>
</tr>
<tr>
<td>Exam Mode / disable Spellcheck and writing supports</td>
<td>N/A</td>
<td>Yes</td>
<td>No</td>
<td>no</td>
<td>No</td>
<td>N/A</td>
</tr>
<tr>
<td>Offline use</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Technical Administration of Chromebooks in SQA examinations

Google suggest three techniques for configuring Chromebooks for assessment purposes⁴⁰:

1. **Scenario 1: Single App Kiosk**⁴¹

   This method restricts the candidate to using a single app or extension, such as Google Docs or Google Forms.

   It is not suitable for candidates who need to use more than one app, e.g. a PDF reader to read the question paper and/or a word processor to type answers, and/or an accessibility extension as well as the word processor.

   Kiosk apps require setting up and programming and it is not clear whether centre staff have expertise to undertake the technical development of Kiosk apps.

   We do not think that the spellchecker and other literacy support tools can be disabled using this method unless a bespoke word processor or text editor app is created.

   Single Kiosk App is therefore unlikely to provide a suitable approach for managing Chromebooks for candidates who require Assessment Arrangements in examinations.

2. **Scenario 2: Exam accounts**⁴²

   With this method, the technical administrator in the presenting centre uses the Google Admin Console to set up accounts that allow candidates access to specific network or internet locations to access the DQPs and/or DABs, and restricts access to any other sources. These exam accounts also only permit the candidate to access the permitted apps and extensions that are required by the candidate for the examination.

   This method allows candidates to access the DQPs, to use accessibility extensions, and to type up answers with a word processor. Of the three scenarios suggested, it therefore offers most of the functionality required for using Chromebooks for Assessment Arrangements. Some technical notes on using this technique are offered in Appendix 1.

   However, we have not been able to find a way to disable the Chrome spellchecker and so this technique is not suitable for candidates who do not have permission to use these facilities.

3. **Scenario 3: Public session kiosks**⁴³

   In this scenario, candidates taking the examination are allocated into *Organisational Units*. Specific policies, settings and resources are applied to the accounts within the organisational unit⁴⁴ and candidates are given access to files and resources required to access the examination. The main

---

⁴⁰ Use Chromebooks for student assessments, [https://support.google.com/chrome/a/answer/3273084?hl=en](https://support.google.com/chrome/a/answer/3273084?hl=en)

⁴¹ Scenario 1: School sets up Chromebook to run as a Single App Kiosk running the exam app. [https://support.google.com/chrome/a/answer/3273084?hl=en](https://support.google.com/chrome/a/answer/3273084?hl=en)

⁴² Scenario 2: Testing provider sets up student accounts for assessment. [https://support.google.com/chrome/a/answer/3273084?hl=en#](https://support.google.com/chrome/a/answer/3273084?hl=en#)

⁴³ Scenario 3: School sets up Public Sessions with student devices; Manage public sessions devices, [https://support.google.com/chrome/a/answer/3017014](https://support.google.com/chrome/a/answer/3017014)

⁴⁴ Set Chrome policies for users, [https://support.google.com/chrome/a/answer/2657289](https://support.google.com/chrome/a/answer/2657289)
difference between this method and the previous scenario is that here, students log on to the Public Session with their own account, whereas in Scenario 2 they use the exam account.

Multiple apps, windows and extensions can be used in Public Session devices which means that a candidate could for example view a DQP and type up answers with a word processor or text editor. It should also be possible to run accessibility extensions.

Again, the Google Admin Console is used to configure the permitted extensions, settings and permissions, and so we do not think that it is possible to prevent access to the spellchecker and other literacy supports.

Summary
Having investigated the three methods suggested by Google, we think that the most suitable method is to use the Google Admin Console to set up accounts for use in examinations – Google Option 2. We have created an initial document that sets out the procedure for setting up Chromebooks for Digital Exams (Appendix 1). This requires testing and refinement by centres before it can be published as guidance.
Commercial Assessment / examination software

A number of software vendors offer tools for delivering and administering assessments and we have investigated some of the options.

**BTL Surpass**

SQA have been working with BTL on e-Assessment systems for many years and piloted the BTL SurpassPaper+ ([http://www.btl.com/surpass/paperplus/](http://www.btl.com/surpass/paperplus/)) system in 2015/16, which is a “a secure word processing app designed specifically for examinations”. Essentially, it is an online Digital Answer Booklet for candidates to type up answers, which locks the candidate in to the assessment and restricts access to tools and features that are not permitted, such as spellchecking. However, neither SurpassPaper+ nor the main Surpass e-Assessment operate Chromebooks.

**ChromeEx**
[https://www.chromex.io/en](https://www.chromex.io/en)

ChromeEx is an application for “creating, administering and assessing digital exams in schools and educational institutions”. It runs in the Google G Suite environment.

ChromeEx runs as a Kiosk app (see Scenario 1: Single App Kiosk) and allows the candidate to view a PDF question paper and type up answers in a word processor. The application can disable the spellchecker. Candidates cannot type into answer boxes or otherwise interact with the paper, and so it is not suitable for use with question-and-answer DQPs. We do not know if the Chrome Select and Speak tool functions in ChromeEx and ChromeEx does not permit extensions to run, so accessibility tools such as Read&Write etc cannot be used.

**DigiExam**
[https://www.digiexam.com/](https://www.digiexam.com/)

DigiExam is an online secure assessment system that works on Windows, MacOS, iOS and Chromebooks. It works in Public Kiosk mode and requires Chromebooks to be managed with the Admin Console. Like ChromeEx it is primarily designed for creating complete examinations and assessments for online delivery, where questions are presented and candidates respond by typing answers to each question. PDF files can be viewed within a DigiExam assessment, and it has a text reader and spellcheck that can be enabled or disabled for specific candidates and examinations, so it could be appropriate for examinations where candidates are using technology to type up answers, and/or read a question-only DQP. It is not suitable for question and answers DQPs because answers cannot be typed into the answer boxes.

---

45 SQA renews e-Assessment contract with BTL Group [https://www.sqa.org.uk/sqa/90399.html](https://www.sqa.org.uk/sqa/90399.html)
Figure 49: DigiExam has a text reader facility

DigiExam was used by Swedish students for national Swedish and English examinations in 2017 and their case stories are available on the DigiExams website: https://www.digiexam.com/stories/.

WISEflow
https://europe.wiseflow.net/

WISEflow is another online assessment and examination delivery platform but the LockDown browser that is used for secure examinations is not available for Chromebooks.

Chromebooks in examinations in practice

An Internet search was conducted to research reported practices and experiences of using Chromebooks in assessments and examinations.

Using Chromebooks for exams

Dean Stokes’ method involves using Google Forms within a public session kiosk. This would not give access to DQPs and it is not clear whether the spellchecker and other literacy tools can be disabled for candidates who are not permitted to use them. The blog notes that this method has not as yet been used in practice for examinations.

- http://blog.deanjstokes.co.uk/2015/02/using-chromebooks-for-exams.html

Setup solution: Chromebooks for exams

Oil Trussell proposes creating a public kiosk session with an HTML editable page, with the possibility of answer boxes. Oil has created answer booklets with answer boxes and custom headers. It is not clear whether DQPs could be accessed or whether the literacy tools can be disabled.

- http://schoolsmartcloud.blogspot.co.uk/2016/10/setup-solution-chromebooks-for-exams.html
- https://docs.google.com/document/d/1TRTpQkbnCJHLZQfW5PKYTdYn5wMzhBpjEROLKPOUJw/edit

Chromebooks for assessment and in-class use: a pilot study.

A 2015 project report from the Department of Curriculum and Quality Enhancement at the University of Portsmouth. The report details procedures for device set up and management and workflows for administering examinations. The pilot project used ‘Containers’ to set up exam profiles and the actual assessments were undertaken using tools such as Google Forms.

- http://www2.port.ac.uk/departments/services/dcqe/storeddocuments/filetodownload,190319,en.pdf

Chromebook E-Exams

Guidance from the Tech for Learning Service in Victoria, British Columbia, Canada, on using Kiosk Mode for examinations. The Guide for Adjudicators is a good example of the type of resource that would be helpful for SQA examinations. The guide however notes that the Read&Write extension that provides access to text to speech and other literacy support tools is not compatible with the exam mode and therefore if a student requires it, he or she will require ‘enhanced supervision’.

- https://techforlearning.sd61.bc.ca/learning-with-chromebooks/exams/
References


Google (2018b) Google Forms - create and analyze surveys, for free. Available at: https://www.google.com/forms/about/ (Accessed: 29 August 2018).


Scottish Qualifications Authority (2016b) *Introduction to Digital Question Papers: Guidance for


Appendix 1: Setting up Chromebook accounts for SQA Examinations

Check with your Local Authority Education ICT team to see if your authority already has a domain and have signed up to the G Suite for Education Programme through Glow. If so, follow their directions for setting up Chromebooks for exam purposes.

Here are our guidelines if you are starting from scratch.

Step 1. Set up Chromebooks for use in examinations
   1. Setup a domain name for your school.
   2. Signup to Google’s G Suite for Education Programme
   3. Purchase a Chrome Education licence for each device.
   4. Setup Google accounts for each Chromebook.
   5. Use the Google Admin Console to setup the Chromebooks.

   1. Setup a domain name for your school
   It is a requirement to have the G Suite account registered against as domain name e.g. www.myschool.org.uk. Speak to your Local Authority IT department on how best to do this. (One suggested site for creating domains is https://www.1and1.co.uk/)

   2. Sign up to Google’s G Suite for Education Programme
   The G Suite for Education programme is free and is designed for schools to manage Chromebooks using the Google Admin console (see step 5). Go to google.com/a/cpanel/education/new to start the sign-up process.
3. Purchase a Chrome Education licence for each device
So that the Chromebooks can be managed through the Google Admin Console. The cost for the licence is:
• Perpetual - £23

See: support.google.com/chrome/a/answer/2717664?hl=en

4. Set up Google Accounts for each Chromebook
1. Set up email addresses using the registered domain from step 1 (e.g. exam1@myschool.org.uk) since each Google ‘exam’ account needs an email address it can be registered against.

2. Create a Google account for each Chromebook using the email address above. Go to accounts.google.com/SignUp to start the sign-up process.

5. Use the Google Admin Console to setup the Chromebooks
Use the console to:
• 5.1 Enrol Chromebooks.
• 5.2 Add Users.
• 5.3 Restrict access to the internet.
• 5.4 Install apps and extensions.
• 5.5 Configure ‘pinned’ apps.
• 5.6 Setup printing.
5.1 Enrol Chromebooks

1. Turn on the Chromebook and follow the onscreen instructions until you see the sign-in screen. Don't sign in yet.
2. Press Ctrl+Alt+E to go to the enrolment screen.
3. Enter the username and password for an Google ‘exam’ account that has eligibility to enrol.

5.2 Add users

1. Login to the Google Admin Console (admin.google.com).
2. Navigate to ‘Users’.
3. Click on the yellow plus sign in the bottom left of the screen.
4. Select ‘Add user’.
5. Enter the user details (Google ‘exam’ account email address) and press ‘Create’.

<table>
<thead>
<tr>
<th>Users</th>
<th>Showing all users</th>
<th>Add new user</th>
<th>Bulk upload users</th>
</tr>
</thead>
</table>
| ![Add a filter](image)

Image 3: Add Users page

5.3 Restrict access to the internet

Block all URL access except those required:

1. Click on ‘Google Admin’ (top left) to get back to the ‘Home Page’.
3. Scroll down to ‘URL Blocking’ section (or use CTRL+F to bring up a search box to find what you are looking for rather than scrolling down the very long list).
4. Under ‘URL Blacklist’ add the following two entries to block everything: http://* and https://*
5. Under the ‘URL Blacklist Exception’ you can now add URLs that you want to allow access to such as https://docs.google.com/.
5.4 Install apps and extensions

Before you can manage specific Chrome apps and extensions, you need to turn on the **Chrome Web Store**:

1. Click on the 3 horizontal lines (top left of screen).
2. Go to ‘**Apps > Additional Google Services**’.
3. Click the name of the service (i.e. myschool.org.uk).
4. At the right of ‘**Chrome Web Store**’, click ‘**More Settings**’ (3 vertical dots) and choose ‘**ON for everyone**’.

Now automatically add Apps and Extensions to Chromebooks:

1. Click on ‘**Google Admin**’ (top left) to get back to the ‘**Home Page**’.
2. Navigate to ‘**Device management>Chrome Management>User Settings**’.
3. Scroll down to ‘**Apps and Extensions**’ section.
4. to ‘force-install’ apps and extensions, click ‘**Manage force-installed apps**’.
5. Click on Chrome Web Store.
6. Search for the apps or extensions that you want to automatically install on devices and click ‘**Add**’.
7. Click ‘**Save**’.
Block all apps and extensions except your ‘allowed apps’:

1. Navigate to ‘Device management>Chrome Management>User Settings’.
2. Scroll down to ‘Allow or Block All Apps and Extensions’.
3. Select ‘Block all apps and extensions except the ones I allow’ from the dropdown menu.
4. Under ‘Allowed Apps and Extensions’ select the apps or extensions that you want to allow and click ‘Add’.

5.5 Configure ‘pinned’ apps

The bar at the bottom of the Chromebook is referred to as the ‘Shelf’.

1. Navigate to ‘Device management>Chrome Management>User Settings’.
2. Scroll down to ‘Pinned Apps and Extensions’.
3. Select the apps or extensions that you want to automatically pin to the shelf and click ‘Add’.
4. Click ‘Save’.
We've found that accessing files using Google Drive on Google Chrome can cause a few issues:

1. Can be slow and unresponsive.
2. Word Documents cannot be directly opened in Google Docs. They must be downloaded first and then opened in Google Docs.

Using the ‘File’ browser, you can browse ‘Google Drive’ and Word documents can be opened directly in ‘Google Docs’ from ‘Google Drive’.

Since the ‘File’ browser is not an app, you add it as a ‘custom app’. Add the ‘File’ browser to the Shelf as follows:

1. Navigate to ‘Device management>Chrome Management>User Settings’.
2. Scroll down to ‘Pinned Apps and Extensions’.
3. Select ‘Specify a Custom App’.
4. Enter the ID exactly as shown: hhaomjibdihmijegdhdafklkbggdgoj
5. Enter the URL as: http://clients2.google.com/service/update2/crx
6. Click ‘Add’.
7. Click ‘Save’.

Image 7: Specify a custom app
5.6 Set up printing

Before you can print, a network printer needs to be added:

1. Click on ‘Google Admin’ (top left) to get back to the ‘Home Page’.
3. Scroll down to ‘Printing’ section.
4. Under ‘Native Chrome OS Printing’ click on ‘Manage’.
5. A pop-up box will appear, click on ‘Add a Printer’ and enter the details.

The printer will now be available for printing from all Chromebooks.
Step 2. Making Digital Question Papers available to the Chromebook

We decided that Google Classroom did not meet requirements of simplicity since the user would have to download the work files and make a copy within their Google Drive to save the paper. Copying the files straight to the Google ‘exam’ account seemed the most straightforward solution.

1. Open the CD from the SQA or download the digital exam paper onto the computer (‘Admin computer’) which is being used with the Google Admin console.
2. Log in to each Google ‘exam’ account on the Admin computer (e.g. exam1@myschool.org.uk).
3. Click on the 9 squares to access Google Drive. Upload the digital exam paper (New / File Upload).
4. The digital exam paper has now been successfully uploaded to My Drive in the ‘exam’ Google Account.
Step 3. How to access the digital paper on the Chromebook

1. Examiner / teacher switches on the Chromebook and logs into the Google ‘exam’ account.

NOTE: Examiner / teacher will know the password of the exam ‘account’ but it will not be given to the candidate.

2. Candidate clicks on the File browser icon which is sitting on the ‘shelf’.

3. Click on Google Drive > My Drive in the top left hand side of the screen to find the exam paper.
4. Double click on the exam paper.
5. Choose the ‘Open with’ option above the exam paper and choose the preferred app/extension.
NOTE: The default editor can also be set so that step 5 isn’t required.

What the candidate does during the exam
- Complete exam paper using the literacy support tools in selected app / extension – See other documentation for details.
- If using Kami, click on Save / Save Now periodically or use ‘Autosave’ if you have the paid version of Kami.

What to do when the exam is complete
- Candidate clicks on (Kami) Save / Save Now to complete saving process. Closes exam paper and leaves the device.
- Examiner / teacher logs into ‘exam’ account with ‘exam’ account email and password from any device. Go to Google Drive. Click on exam paper. Choose ‘Open with’ preferred app e.g. Kami. Choose print icon.
## Appendix 2: Chrome PDF Viewers

<table>
<thead>
<tr>
<th>Feature</th>
<th>Chrome (Online) PDF Viewer and Offline PDF Viewer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open DQP</td>
<td>Online Viewer: double click to open from Google Drive in the browser window. Offline Viewer: Open from Google Drive, download to the Chromebook then open in the offline PDF Viewer.</td>
</tr>
<tr>
<td>Save DQP</td>
<td>Yes, answers can be saved using the Offline Viewer – click Save and rename or replace the previous file. Answers cannot be typed or saved with the Online Viewer.</td>
</tr>
<tr>
<td>Autosave DQP</td>
<td>No.</td>
</tr>
<tr>
<td>Open PDF DABs</td>
<td>Yes, answers can be typed in and saved with the Offline Viewer.</td>
</tr>
<tr>
<td>Open .doc DABs</td>
<td>No</td>
</tr>
<tr>
<td>Autosave DAB</td>
<td>No</td>
</tr>
<tr>
<td>View DQP and DAB side by side</td>
<td>Yes, the DQP and word processor for typing answers can be viewed side by side or top and bottom.</td>
</tr>
<tr>
<td>Printing</td>
<td>Yes, the DQP with answers and DAB PDFs can be printed.</td>
</tr>
<tr>
<td>Copy Candidate ID on each page</td>
<td>Yes, with the offline Viewer.</td>
</tr>
<tr>
<td>Exam Mode / disable Spellcheck and writing supports</td>
<td>No.</td>
</tr>
<tr>
<td>Offline use</td>
<td>Yes</td>
</tr>
<tr>
<td>Zoom / magnify</td>
<td>Yes – (small) buttons to zoom in and out.</td>
</tr>
<tr>
<td>Feature</td>
<td>Online Viewer</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Reflow to fit screen?</td>
<td>No</td>
</tr>
<tr>
<td>Navigate with Bookmarks and page thumbnails?</td>
<td></td>
</tr>
<tr>
<td>Page turn / scroll</td>
<td>Touch; mouse scroll; scroll bar; keyboard Spacebar; arrow keys.</td>
</tr>
<tr>
<td>Change colours</td>
<td>No</td>
</tr>
<tr>
<td>Read with computer text reader</td>
<td></td>
</tr>
<tr>
<td>Voices available</td>
<td>Standard Chrome voices: two UK (English) accents are available. Acapela voices can also be purchased.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Scottish computer voices</strong></td>
<td>Yes, by buying Acapela’s Rhona voice.</td>
</tr>
<tr>
<td><strong>MFL computer voices</strong></td>
<td>Yes, many languages are available free with Chrome.</td>
</tr>
<tr>
<td><strong>Keyboard only access</strong></td>
<td>Space and arrow keys to navigate. TAB between answer boxes.</td>
</tr>
<tr>
<td><strong>Mouse only access</strong></td>
<td>Yes - via the Chrome on-screen keyboard.</td>
</tr>
<tr>
<td><strong>Type into answer boxes</strong></td>
<td>Yes with the offline PDF Viewer, no with the online viewer. The answer boxes behave much like Adobe Reader on Windows: the borders are red until the candidate clicks in one to start typing; they are opaque, so any handwriting guides are not seen; and if the candidate fills up the field, the font size starts to reduce.</td>
</tr>
<tr>
<td><strong>Tick boxes</strong></td>
<td>Yes with the offline PDF Viewer, no with the online viewer.</td>
</tr>
<tr>
<td><strong>Drawing tools</strong></td>
<td>Yes. Offline Viewer has freehand drawing. We found there was a significant delay after clicking the Annotation button before the toolbar appeared, and often the Viewer would crash before the Toolbar appeared.</td>
</tr>
<tr>
<td><strong>The offline viewer has a Comment tool but comments are not printed.</strong></td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Annotation tools</td>
<td>No apart from drawing.</td>
</tr>
<tr>
<td>Spellchecker</td>
<td>No: words are underlined but no spellcheck list is offered.</td>
</tr>
<tr>
<td>Literacy supports</td>
<td>No.</td>
</tr>
<tr>
<td>Computer dictation</td>
<td>Yes, use Google Dictation.</td>
</tr>
<tr>
<td>Insert maths &amp; science</td>
<td>No.</td>
</tr>
<tr>
<td>expressions</td>
<td></td>
</tr>
</tbody>
</table>
## Appendix 3: DocsPlus

<table>
<thead>
<tr>
<th>Feature</th>
<th>DocsPlus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open DQP</td>
<td>Open from Google Drive or from the Chromebook files into the DocReader.</td>
</tr>
<tr>
<td>Save DQP</td>
<td>Yes</td>
</tr>
<tr>
<td>Autosave DQP</td>
<td>Yes - changes are automatically saved.</td>
</tr>
<tr>
<td>Open PDF DABs</td>
<td>Yes, although you cannot open both the DQP and the DAB in DocReader at the same time, which means it is not a viable option for candidates who need to use both. The amount of text that can be typed into an answer box seems too limited for practical use.</td>
</tr>
<tr>
<td>Open .doc DABs</td>
<td>No – use the Document word processor and save as DocsPlus or .docx file.</td>
</tr>
<tr>
<td>Autosave DAB</td>
<td>Yes</td>
</tr>
<tr>
<td>View DQP and DAB side by side</td>
<td>No - you cannot view the paper and answers at the same time. Also, you cannot copy a question from the DQP and paste it into the document as an aide-memoire for answering the question.</td>
</tr>
<tr>
<td>Printing</td>
<td>Yes - for a Document.</td>
</tr>
<tr>
<td></td>
<td>No - for a DQP. The file can be opened in another PDF reader for printing, or emailed, but the answers did not appear properly in the Chrome PDF reader (see below), although we found that the text could be seen in Kami.</td>
</tr>
<tr>
<td>Copy Candidate ID on each page</td>
<td>DQP - No - the candidate number is not copied to each page in the DQP. DAB – No - there are no headers or footers in the Document window so candidate information cannot be copied to each page.</td>
</tr>
<tr>
<td>Exam Mode / disable Spellcheck and writing supports</td>
<td>Yes. The Exam Mode can enable or disable the word bank, prediction, spellchecking, speech, DocReader and editing options.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Offline use</td>
<td>Yes. Tap the View button and use the slider or Fit Width / Fit Page.</td>
</tr>
<tr>
<td>Zoom / magnify</td>
<td>The maximum font size is not particularly large - about 14-16 point on the test Asus with 10” screen.</td>
</tr>
<tr>
<td>Reflow to fit screen?</td>
<td>No</td>
</tr>
<tr>
<td>Navigate with Bookmarks and page thumbnails?</td>
<td>No.</td>
</tr>
<tr>
<td>Page turn / scroll</td>
<td>Click buttons to navigate between pages. Once on a page the arrow keys and Space bar can scroll the page.</td>
</tr>
<tr>
<td><strong>Change colours</strong></td>
<td>No. The background and text colour of the PDF cannot be changed in DocReader. (They can in the DocsPlus document when writing answers.)</td>
</tr>
<tr>
<td>--------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Read with computer text reader</strong></td>
<td>Yes – a good text reader is provided in DocReader. Select the text and click the Play button. Each word is highlighted as it is read.</td>
</tr>
<tr>
<td><img src="image_url" alt="Image" /></td>
<td>Chrome’s Select and Speak can also be used to read the DQP.</td>
</tr>
<tr>
<td><strong>Voices available</strong></td>
<td>Chrome UK voices and Acapela Rachel.</td>
</tr>
<tr>
<td><img src="image_url" alt="Voice options" /></td>
<td>Scottish computer voices? Not for the DocsPlus text reader, but the Chrome Select and Speak tool can be used to read the DQP in DocsPlus, and the Rhona Scottish voice is available for around £6 per account.</td>
</tr>
<tr>
<td><img src="image_url" alt="Voice options" /></td>
<td>MFL computer voices? Not known with DocsPlus; many with Select and Speak.</td>
</tr>
<tr>
<td><strong>Keyboard only access</strong></td>
<td>Candidates can TAB between answer boxes but the keyboard cannot be used to move from page to page in the DocReader - candidates have to tap or click buttons. Arrow keys and space bar can be used to navigate within the page.</td>
</tr>
<tr>
<td><strong>Mouse only access</strong></td>
<td>Yes – DocsPlus has its own onscreen keyboard with the option of SuperKeys for people with visual or physical challenges. The Google OSK can also be used.</td>
</tr>
</tbody>
</table>
Type into answer boxes? Yes. Answers can be typed into answer boxes in the DQP, with support from the word predictor and spellchecker. The text size seems quite large and the text scrolls up as more text is typed in, which means that even if the PDF could be printed, the printout would only show the visible text. DocsPlus is therefore not recommended for Question and Answer DQPs.

Tick boxes? Yes
Drawing tools? No
Annotation tools? None
Spellchecker? Yes - talking spellchecker

Literacy supports
Word prediction, word banks, spellchecker, computer text reader. The literacy support tools can be used in both documents and for typing into DQP answer boxes. The words in the predictor and other tools can be spoken out.

Word predictor
The predictor uses ‘flexible spelling’ so that it can handle spelling errors.

Spelling errors are identified with a red line - click on the word to see suggestions.

The wordbar feature offers word bank support. Wordbars can be created for particular topics and ready-made wordbars are available on the Crick Learning Grid web site.
<table>
<thead>
<tr>
<th>Computer dictation</th>
<th>Yes, Google Voice typing can be used in a Document and to dictate into a DQP in the DocReader.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type maths &amp; science expressions</td>
<td>No</td>
</tr>
</tbody>
</table>
# Appendix 4: Kami

<table>
<thead>
<tr>
<th>Feature</th>
<th>Kami</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open DQP</td>
<td>Open from Google Drive or from the Chromebook files.</td>
</tr>
<tr>
<td>Save DQP</td>
<td>Yes</td>
</tr>
<tr>
<td>Autosave DQP</td>
<td>Yes</td>
</tr>
<tr>
<td>Open PDF DABs</td>
<td>Yes</td>
</tr>
<tr>
<td>Open .doc DABs</td>
<td>No</td>
</tr>
<tr>
<td>Autosave DAB</td>
<td>Yes – PDF DABs</td>
</tr>
<tr>
<td>View DQP and DAB side by side</td>
<td>Yes - drag one tab to a separate location on screen, click and hold on the Maximise button until you see the two horizontal arrows, then choose either the left or right arrow to dock the window. Drag and re-size the windows manually if you want to see them on top and bottom of the screen.</td>
</tr>
<tr>
<td>Printing</td>
<td>Yes</td>
</tr>
<tr>
<td>Copy Candidate ID on each page</td>
<td>No - the ID is not automatically copied across each page.</td>
</tr>
<tr>
<td>Exam Mode / disable Spellcheck and writing supports</td>
<td>No.</td>
</tr>
<tr>
<td>Offline use</td>
<td>Yes</td>
</tr>
<tr>
<td>Zoom / magnify</td>
<td>Yes - click the + and - buttons on the toolbar to zoom in and out, or press CTRL- or CTRL+ or use Zoom Options button and choose to view a Full page, Page Width, or zoom up to 400%. Kami cannot reflow the paper at high levels of zoom and so you will need to scroll horizontally to read the paper.</td>
</tr>
</tbody>
</table>

When the organisers of the 2015 Super Bc footsteps of Diana Ross and Whitney Hou front of a global audience of 160 million, it’.

As the voice of Elsa the ice queen in Frozef who sang its ubiquitous Oscar-winning let

<p>| Reflow to fit screen?          | No.                                  |
| Navigate with Bookmarks and page thumbnails? | Yes. |
| Page turn / scroll             | Touch; mouse scroll; scroll bar; keyboard Spacebar; arrow keys. |</p>
<table>
<thead>
<tr>
<th>Change colours</th>
<th>No.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Read with computer text reader</strong></td>
<td>Yes - click the Text to Speech button, select the text and it will be read out with each word highlighted as it is read. Kami does not seem to be able to read answers typed into answer boxes.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Voices available</strong></th>
<th>A range of voices, but only one UK (female) English voice.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scottish computer voices?</strong></td>
<td>Yes, by buying Acapela’s <em>Rhona</em> voice.</td>
</tr>
<tr>
<td><strong>MFL computer voices?</strong></td>
<td>Yes.</td>
</tr>
<tr>
<td><strong>Keyboard only access</strong></td>
<td>Space and arrow keys to navigate; TAB between answer boxes.</td>
</tr>
<tr>
<td><strong>Mouse only access</strong></td>
<td>Yes - via the Chrome on-screen keyboard.</td>
</tr>
<tr>
<td><strong>Type into answer boxes</strong></td>
<td>Yes. Kami does not show the red borders on the answer boxes and the boxes are pale grey. The boxes are transparent, and any handwriting guides are visible, which may be distracting for some candidates.</td>
</tr>
<tr>
<td><strong>Tick boxes</strong></td>
<td>Yes.</td>
</tr>
<tr>
<td><strong>Drawing tools</strong></td>
<td>Yes. Freehand drawing; draw square, circle and line.</td>
</tr>
<tr>
<td><strong>Annotation tools?</strong></td>
<td>Yes. Highlighter; strikethrough; underline; insert Text, voice, video, screen capture Comments, Text Box, Equation; insert image.</td>
</tr>
</tbody>
</table>
### Spellchecker?
Yes. Built-in Chrome spellchecker - select a word and right click to see spellchecker suggestions.

### Literacy supports
Right click and use Google Lookup (if connected to the internet).

### Computer dictation
Yes, use Google Dictation.

### Type maths & science expressions
Yes, Kami has an equation editor that can be used to add an equation on top of an answer box.
## Appendix 5: Snap&Read PDF Reader

<table>
<thead>
<tr>
<th>Feature</th>
<th>Snap&amp;Read PDF Reader</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open DQP</td>
<td>Open from Google Drive, OneDrive or from the Chromebook.</td>
</tr>
<tr>
<td>Save DQP</td>
<td>Yes, to the device itself. Saving to Google Drive on OneDrive did not function on our test machine. A new file is created each time the file is saved, which may be confusing for candidates.</td>
</tr>
<tr>
<td>Autosave DQP</td>
<td>No</td>
</tr>
<tr>
<td>Open PDF DABs</td>
<td>Yes</td>
</tr>
<tr>
<td>Open .doc DABs</td>
<td>No – but Snap&amp;Read can read from Google Docs.</td>
</tr>
<tr>
<td>Autosave DAB</td>
<td>No</td>
</tr>
<tr>
<td>View DQP and DAB side by side</td>
<td>Yes.</td>
</tr>
<tr>
<td>Printing</td>
<td>Yes, answers typed on a DQP can be printed.</td>
</tr>
<tr>
<td>Copy candidate ID on each page</td>
<td>No</td>
</tr>
<tr>
<td>Exam Mode / turn off Spellcheck and support tools</td>
<td>No</td>
</tr>
<tr>
<td>Offline use</td>
<td>No</td>
</tr>
<tr>
<td>Zoom / magnify</td>
<td>Yes, zoom in and out; fit width and fit page.</td>
</tr>
<tr>
<td>Reflow to fit screen?</td>
<td>No</td>
</tr>
<tr>
<td>Navigate with Bookmarks and page thumbnails?</td>
<td>Yes.</td>
</tr>
<tr>
<td>Page turn / scroll</td>
<td>Touch; mouse scroll; scroll bar; keyboard Spacebar; arrow keys.</td>
</tr>
<tr>
<td>Change colours</td>
<td>Yes and no - there is a colour overlay feature but we could not get it to work. There is also a line reading ruler which did function.</td>
</tr>
<tr>
<td>Read with computer text reader</td>
<td>Yes. Snap&amp;Read has a useful text reader. Either turn it on and click on text and the reader will read from that point, or select the text and click Speak.</td>
</tr>
</tbody>
</table>
**Voices available**

A range of (online) voices are offered, and the Chrome UK voices can also be used.

<table>
<thead>
<tr>
<th>Scottish computer voices?</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>MFL computer voices?</td>
<td>Yes, a range of free eSpeak and Chrome voices.</td>
</tr>
<tr>
<td>Keyboard only access</td>
<td>Limited – Space; arrow keys to navigate. You cannot type into or TAB between answer boxes.</td>
</tr>
<tr>
<td>Mouse only access</td>
<td>Yes</td>
</tr>
<tr>
<td>Type into answer boxes?</td>
<td>No. Snap&amp;Read does have a Text Comment tool which can be used to type on top of the PDF. We found that we could not type on top of an answer box, but it did work if we starting typing outside the box. Candidates will have to be careful to re-size their answers so that they do not exceed the scanned area of the page. The feature is more complex than typing into answer boxes. The font, colour, size, style and alignment can be set.</td>
</tr>
<tr>
<td>Tick boxes?</td>
<td>No - use the line tool or Text Comment.</td>
</tr>
<tr>
<td>Drawing tools?</td>
<td>Yes - Line Tool.</td>
</tr>
<tr>
<td>Annotation tools?</td>
<td>Yes - highlight box.</td>
</tr>
<tr>
<td>Spellchecker?</td>
<td>Yes - the built in Chromebook spellcheck.</td>
</tr>
<tr>
<td>Literacy support</td>
<td>Yes.</td>
</tr>
</tbody>
</table>
Snap&Read has an Outline feature which can be used to capture text from the DQP. This could be useful for taking notes during an exam.

There is a Define tool that provides a definition of a word, with symbol support.

Snap&Read has a tool to simplify text, which would probably not be permitted in an examination.

There is a Translate Tool, which again would not be permitted in an examination.

<table>
<thead>
<tr>
<th>Computer dictation</th>
<th>Yes - Google Dictation works with the Text Comments.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type maths &amp; science expressions</td>
<td>No</td>
</tr>
</tbody>
</table>
## Appendix 6: Texthelp PDF Reader

<table>
<thead>
<tr>
<th>Feature</th>
<th>Texthelp PDF Reader</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open DQP</td>
<td>Open from Google Drive or the Chromebook files.</td>
</tr>
<tr>
<td>Save DQP</td>
<td>Yes, although a new file is created with each save, and so candidates will generate multiple copies and care will be required to ensure the most recent version is printed.</td>
</tr>
<tr>
<td>Autosave DQP</td>
<td>No</td>
</tr>
<tr>
<td>Open PDF DABs</td>
<td>PDF – yes, open and use the Typewriter to type on top.</td>
</tr>
<tr>
<td>Open .doc DABs</td>
<td>No – use a word processor and Read&amp;Write.</td>
</tr>
<tr>
<td>Autosave DAB</td>
<td>No</td>
</tr>
<tr>
<td>View DQP and DAB side by side</td>
<td>Yes – position the windows as needed.</td>
</tr>
<tr>
<td>Printing</td>
<td>Yes.</td>
</tr>
<tr>
<td>Copy candidate ID on each page</td>
<td>No.</td>
</tr>
<tr>
<td>Exam Mode / disable Spellcheck and writing supports</td>
<td>No</td>
</tr>
<tr>
<td>Offline use</td>
<td>No</td>
</tr>
<tr>
<td>Zoom / magnify</td>
<td>Yes. Zoom in and out by touch or use +/- buttons, and Fit Width, Fit Page, or choose a zoom value.</td>
</tr>
<tr>
<td>Reflow to fit screen?</td>
<td>No</td>
</tr>
<tr>
<td>Navigate with Bookmarks and page thumbnails?</td>
<td>Yes – the bookmarks are displayed at the left of the screen. Page thumbnails can also be shown to aid navigation around the paper.</td>
</tr>
<tr>
<td>Page turn / scroll</td>
<td>Touch; mouse scroll; scroll bar; keyboard Spacebar; arrow keys.</td>
</tr>
<tr>
<td>Change colours</td>
<td>No.</td>
</tr>
<tr>
<td>Read with computer text reader</td>
<td>Yes – the PDF Reader text to speech is a strength of the product and is available in both free and premium subscriptions. There are two modes of operation. First is to select some text and click the Play button, and the text will be read out and highlighted as it is read. The</td>
</tr>
</tbody>
</table>
second is to turn on **Click to Speak** then click or tap on a sentence and it will be read out. There is an option for Continuous Reading where the reader will then go on and read the next sentence until the **Pause** or **Stop** button is clicked. In an exam Click and Speak is faster and more convenient than the select and speak method. The reader highlights the sentence being read and each word as it is read out.

**Screenshot reader**

A Screenshot Reader is provided for ‘image text’ that cannot be read out by the text reader because it is not actual text. All SQA papers have readable text, so this should not be required in SQA examinations but it may be useful for other files. To use the ScreenShot Reader, draw a box round the text and after a short delay, it will be read out.

<table>
<thead>
<tr>
<th>Voices available</th>
<th>Range of UK and US voices.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scottish computer voices?</td>
<td>Yes – Fiona (Vocaliser) is available in Read&amp;Write, and Acapela’s Rhona voice will also work if it has been purchased and installed on the Chromebook.</td>
</tr>
<tr>
<td>MFL computer voices?</td>
<td>Yes, in various languages.</td>
</tr>
<tr>
<td>Keyboard only access</td>
<td>Limited. Space; arrow keys to navigate. You cannot type into or TAB between answer boxes.</td>
</tr>
<tr>
<td>Mouse only access</td>
<td>Yes - via the Chrome on-screen keyboard.</td>
</tr>
<tr>
<td>Type into answer boxes?</td>
<td>No. Candidates cannot click and type into the form fields on the PDF. With Premium, the Typewriter tool can type ‘on top’ of answer boxes. This is not as convenient as actually typing into the answer box and users cannot click on a tick box or Tab between answer boxes; and any text outwith the fiducials on the page will not be scanned by SQA’s e-marking system. On the other hand, the Typewriter does have advantages compared to the standard PDF form fields:</td>
</tr>
<tr>
<td></td>
<td>● The text box created by the Typewriter tool can be moved and resized, and the font size and colour can be changed.</td>
</tr>
<tr>
<td></td>
<td>● Answers can be read back with the <strong>Play</strong> button;</td>
</tr>
<tr>
<td></td>
<td>● Users can dictate into the answer box using speech recognition;</td>
</tr>
<tr>
<td></td>
<td>● Users can use word prediction.</td>
</tr>
</tbody>
</table>
The free version does have a comment tool but it is not suitable for the DQPs because comments are not printed.

**Tick boxes?**
No – you have to type an X on top, draw freehand or draw a shape round the answer.

**Drawing tools?**
Yes, freehand drawing; draw square, circle and lines (premium subscription).

**Annotation tools?**
Text comments, audio comments, highlighters (premium subscription). Use the highlighters to mark up quotes and text from a DQP which can be collated automatically in a Google Doc.

**Spellchecker?**
Yes. Standard Chrome spellchecker - select a word and right click to see spellchecker suggestions.

**Literacy supports**
Word prediction, Picture Dictionary, Online Dictionary, highlighter to collect notes and quotes, translator.

Dictionary:

**Picture Dictionary (Widgit symbols):**
<table>
<thead>
<tr>
<th>Computer dictation</th>
<th>Yes, candidates can dictate into the Typewriter with Talk&amp;Type.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type maths &amp; science expressions</td>
<td>Yes, via TextHelp’s <a href="#">Equatio</a> which provides an equation editor with handwriting recognition and prediction.</td>
</tr>
</tbody>
</table>

[Equatio](#)
## Appendix 7: Xodo

<table>
<thead>
<tr>
<th>Feature</th>
<th>Xodo</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open DQP</td>
<td>Open from Google Drive or from the Chromebook files.</td>
</tr>
<tr>
<td>Save DQP</td>
<td>Yes – Save will automatically create a new file each time unless you rename it manually.</td>
</tr>
<tr>
<td>Autosave DQP</td>
<td>No</td>
</tr>
<tr>
<td>Open PDF DABs</td>
<td>Yes</td>
</tr>
<tr>
<td>Open .doc DABs</td>
<td>No</td>
</tr>
<tr>
<td>Autosave DAB</td>
<td>No</td>
</tr>
<tr>
<td>View DQP and DAB side by side</td>
<td>Yes.</td>
</tr>
<tr>
<td>Printing</td>
<td>Yes.</td>
</tr>
<tr>
<td>Copy Candidate ID on each page</td>
<td>Yes- the ID is automatically copied across each page.</td>
</tr>
<tr>
<td>Exam Mode / disable Spellcheck and writing supports</td>
<td>No.</td>
</tr>
<tr>
<td>Offline use</td>
<td>No</td>
</tr>
<tr>
<td>Zoom / magnify</td>
<td>Yes - buttons for Full Page and Page Width, and zoom in and out.</td>
</tr>
<tr>
<td>Reflow to fit screen?</td>
<td>No</td>
</tr>
<tr>
<td>Navigate with Bookmarks and page thumbnails?</td>
<td>Yes.</td>
</tr>
<tr>
<td>Page turn / scroll</td>
<td>Touch; mouse scroll; scroll bar; keyboard Spacebar; arrow keys.</td>
</tr>
<tr>
<td>Change colours</td>
<td>No.</td>
</tr>
<tr>
<td>Read with computer text reader</td>
<td>No. Xodo for Chromebook does not provide a built-in text reader. We could not get the Chromebook Select to Speak, Read&amp;Write or ClaroRead Chrome to read from a PDF in Xodo. (Xodo for Android is claimed to have a text to speech facility, and you can buy the Scottish Voices for 59p each for Android, so this may be an option if your Chromebook can run Android apps.</td>
</tr>
<tr>
<td>Voices available</td>
<td>N/A</td>
</tr>
<tr>
<td>Scottish computer voices?</td>
<td>N/A</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MFL computer voices?</td>
<td>N/A</td>
</tr>
<tr>
<td>Keyboard only access</td>
<td>Good – Xodo has keyboard shortcuts for annotations. Space; arrow keys to</td>
</tr>
<tr>
<td></td>
<td>navigate. TAB to move between answer boxes.</td>
</tr>
<tr>
<td>Mouse only access</td>
<td>Yes - via the Chrome on-screen keyboard.</td>
</tr>
<tr>
<td>Type into answer boxes?</td>
<td>Yes. The answer boxes in Xofo work well - the red borders are visible and</td>
</tr>
<tr>
<td></td>
<td>the boxes are opaque to that handwriting guides are hidden. Users can TAB</td>
</tr>
<tr>
<td></td>
<td>between answer boxes.</td>
</tr>
<tr>
<td>Tick boxes?</td>
<td>Yes.</td>
</tr>
<tr>
<td>Drawing tools?</td>
<td>Yes. Freehand drawing; draw square, circle, line, arrowed line, connected</td>
</tr>
<tr>
<td></td>
<td>line, polygon, cloud.</td>
</tr>
<tr>
<td>Annotation tools?</td>
<td>Yes. Highlighter; strikethrough; underline; insert note, insert image.</td>
</tr>
<tr>
<td>Spellchecker?</td>
<td>No. When the Chromebook spell check is enabled, suspect mis-spellings are</td>
</tr>
<tr>
<td></td>
<td>underlined in red but we could not find a way to actual use the spellchecker.</td>
</tr>
<tr>
<td></td>
<td>Right clicking on the word (the usual method) gave the Xodo annotation</td>
</tr>
<tr>
<td></td>
<td>menu, but not the spellchecker list.</td>
</tr>
<tr>
<td>Literacy supports</td>
<td>No.</td>
</tr>
<tr>
<td>Computer dictation</td>
<td>Yes, use Google Dictation.</td>
</tr>
<tr>
<td>Type maths &amp; science expressions</td>
<td>No.</td>
</tr>
</tbody>
</table>
CALL Scotland

Communication, Access, Literacy and Learning
The Moray House School of Education
The University of Edinburgh
Paterson's Land, Holyrood Road
Edinburgh EH8 8AQ

www.callscotland.org.uk